DIALOGS AND ALERTS

Includes Demonstration Program DialogsAndAlert

Introduction

Alerts and alert boxes warn the user whenever an unusual or potentially undesirable
situation occurs within your application. An alert box, unlike a dialog box, typically
requires only the user's acknowledgment in order for your application to proceed.

Dialog boxes allow the user to provide additional information or to modify settings before
your application carries out a command.

Types of Alerts and Alert Boxes

When an alert condition occurs, and depending on the nature of that condition, your
application can simply play an alert sound' or it can display an alert box. Your
application can also base its response on the number of consecutive times the condition
occurs, possibly playing an alert sound at first and subsequently displaying an alert box.

Types of Alert Box

There are two types of alert box: the modal alert box and the movable modal alert
box. Both types are shown at Fig 1.

Modal Alert Box

The fixed-position modal alert box places the user in the state, or mode, of being able to
work only inside the alert box. The only response the user receives when clicking
anywhere outside the alert box is the alert sound, and the user is not be able to bring
another application to the front before first dismissing the alert box.

Movable Modal Alert Box

Movable modal alert boxes retain the essentially modal characteristic of their fixed-
position counterpart, the main differences being that they allow the user to:

. Drag the alert box so as to uncover obscured areas of an underlying window.

! The system alert sound is a sound resource stored in the System file. It is played whenever the system software or
your application uses the Sound Manager function SysBeep. The alert sound should be used for errors which are minor and
immediately obvious, such as attempting to backspace past the left boundary of a text field.
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. Bring another application to the front by clicking in one of the application's
windows or by choosing the application's name from the Application menu.

Historical Note

The movable modal alert box was introduced with OS 8 and the Appearance
Manager.

Generally speaking, the movable modal alert box is more appropriate for use in a multi-
tasking environment. The modal alert box should be used only where there is

justification for denying the user access to other running applications before it is
dismissed.

Levels of Alerts

An alert box can display either one of three levels of alert, depending on the nature of the
situation the alert box is reporting to the user. The three levels of alert, which are
identified by icons supplied automatically by the system, are as follows:

. Note Alert. The note alert is used to inform users of an occurrence which will not
have serious consequences. Usually, a note alert simply offers information.

Sometimes, a note alert may ask a simple question and provide, via the push
buttons, a choice of responses.
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File names cannot contain a colon.

The old mame has been restored.

2

A NOTE ALERT DISPLAYED IN A MOVABLE MODAL ALERT BOX

f Do you really want to delete "Barney"?
Thiz action cannot be undone.

s |Cnm:EII | OK I

A CAUTION ALERT DISPLAYED IN A MOVABLE MODAL ALERT BOX

The Color 5W 2500 is out of paper. Please
add paper, then click Continue.

[ Cancel I || Continue ]l

A STOP ALERT DISPLAYED IN A MODAL ALERT BOX
FIG 1 - MODAL AND MOVABLE MODAL ALERT BOXES
. Caution Alert. The caution alert is used to alert the user to an operation which

may have undesirable results if it is allowed to continue. As shown at Fig 1, you

should provide the user, via the push buttons, with a choice of whether to continue
or stop the action.

. Stop Alert. The stop alert is used to inform the user that a problem or situation is
so serious that the action cannot be completed.

Custom Alert Boxes

You can also create custom alert boxes, which might contain your own icons (or,
possibly, no icons). Custom alert boxes are typically used for About... boxes.
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Types Of Dialogs Boxes

There are three types of dialog box, all of which are illustrated in the examples at Fig 2.

Grids and Rulers
[] Grid Snap [ Show Grid [] Show Rulers

|Cance|| | (0] 4 I

MODAL DIALOG BOX

Brushes

Brush Type
@ Charcoal O 0il Paint O Pencil ) Chalk

[ Cancel ]

MOVABLE MODAL DIALOG BOX

Search For: ||

MODELESS DIALOG BOX

FIG 2 - MODAL, MOVABLE MODAL, AND MODELESS DIALO(

Modal Dialog Boxes

Fixed-position modal dialog boxes place the user in the state, or mode, of being able to
work only inside the dialog box. The only response the user receives when clicking
outside the dialog box is the alert sound. This type of dialog box looks like a modal alert
box except that it may contain other types of controls in addition to push buttons.

Modal dialog boxes really belong to the era before the Mac OS became a multi-tasking
operating system. Accordingly, they should be used only where there is justification for
denying the user access to other running applications before they are dismissed.

Movable Modal Dialog Boxes

Movable modal dialog boxes retain the essentially modal characteristic of their fixed-
position counterpart, the main differences being that they allow the user to:

. Drag the dialog box so as to uncover obscured areas of an underlying window.

Dialogs and Alerts



. Bring another application to the front by clicking in one of the application's
windows or by choosing the application's name from the Application menu.

The absence of close boxes and zoom boxes in the title bar of a movable modal dialog box
visually suggests to the user that the dialog box is modal rather than modeless.

Modeless Dialog Boxes

Modeless dialog boxes look and behave very like document windows, except for their
interior colour/pattern and the one-pixel frame just inside the window frame. Modeless
dialog boxes do not require the user to respond before doing anything else. The user
should be able to move the dialog box, activate and deactivate it, and close it like any
document window; however, unlike document windows, the modeless dialog box should
contain no scroll bars and no size box.

When you display a modeless dialog box, your application must allow the user to perform
other operations without first dismissing the dialog.

Because of the difficulty of revoking the last action invoked from a modeless dialog box,

it typically does not have a Cancel button, although it may have a Stop button to halt long
operations such as searching and printing.

Window Types For Alerts and Dialogs

Fig 3 shows the seven available Appearance-compliant window types for alerts and
dialogs and the constants that represent the window definition IDs for those types. Note
that modeless dialogs are a special case in that a normal document window type is used.

The window definition ID is derived by multiplying the resource ID of the WDEF by 16
and adding the variation code to the result, as is shown in the following:

WDEF Variation |Window Definition ID Window Definition ID
Resource ID Code (Value) (Constant)

65 0 65*16 + 0 = 1040 kWindowPlainDialogProc

65 1 65*16+1 =1041 kWindowShadowDialogProc

65 2 65*16 + 2 =1042 kWindowModalDialogProc

65 3 65*16 + 3 = 1043 kWindowMovableModalDialogProc
65 4 65*16 +4 =1044 kWindowAlertProc

65 5 65*16+5 = 1045 kWindowMovableAlertProc

64 0 64*16+ 0 = 1024 kWindowDocumentProc
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Modal dialog box Modal dialog box,
shadow

kWindowPlainDialogProc kWindowShadowDialogProc
Modal dialog box Movable modal dialog bo
kWindowModalDialogProc kWindowMovableModalDialogProc
Modal alert box Movable modal alert box
kWindowAlertProc kWindowMovableAlertProc
=— untitled =H

Modeless dialog box

kWindowDocumentProc

FIG 3 - WINDOW TYPES FOR DIALOGS AND ALERTS

Historical Note

The old pre-Mac OS 8, pre-Appearance Manager window types, and their
Appearance-compliant equivalents, are as follows.

Pre-Appearance Appearance-Compliant Description

(None) kWindowAlertProc Modal alert box.

dBoxProc kWindowModalDialogProc Modal dialog box.

plainDBox kWindowPlainDialogProc Modal dialog box.

altDBoxProc kWindowShadowDialogProc Modal dialog box, shadow.

(None) kWindowMovableAlertProc Movable modal alert box.

movableDBoxProc kWindowMovableModalDialogProc Movable modal dialog box.

noGrowDocProc kWindowDocumentProc Document window and modeless
dialog box.

Items in Alert and Dialog Boxes

You use item lists, which are resources of type 'DITL', to specify the items to appear in
alert boxes and dialog boxes.

Alert boxes should usually contain only informative text and push button controls. Dialog
boxes may contain informative or instructional text and controls.
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Default Push Buttons

Your application should specify a default push button for every alert and dialog box.
The default push button, which is visually identified by the default ring drawn around it,
should be the one the user is more likely to click in most circumstances. However, if the
most likely choice is at all destructive (for example, erasing a disk or deleting a file), you
should consider defining the Cancel button as the default.

Removal of Alert and Dialog Boxes

The Dialog Manager automatically removes and disposes of an alert box when the user
clicks its its OK or Cancel push button.

Your application should remove and dispose of a modal dialog box or movable modal
dialog box only when the user clicks its OK or Cancel push button.

Your application should not remove a modeless dialog box unless the user clicks its close
box or chooses Close from the File menu when the modeless dialog box is the active
window. (Typically, a modeless dialog is simply hidden, not disposed of, when the user
user clicks the close box or chooses Close.)

Creating Alert Boxes

Alert boxes may be created in one of two ways:

. Using the functions Alert, NoteAlert, CautionAlert and StopAlert, which take descriptive
information about the alert from alert ('ALRT') and extended alert (‘alrx') resources.
The resource ID of the 'ALRT' and ‘alrt' resources must be the same, and is passed in
the first parameter of these functions. You specify whether the alert is to be
displayed in a modal alert box or a movable modal alert box by setting a particular
flag in the 'alrx' resource.

. Using the function standardAlert, which optionally takes additional descriptive
information about the alert from a standard alert structure (a structure of type
AlertStdAlertParamRec). You specify whether the alert is to be a plain, note, caution, or
stop alert in the first parameter of the standardAlert call. You specify whether the
alert is to be displayed in a modal alert box or a movable modal alert box by
assigning a value to the first field of the standard alert structure.

Historical Note

The extended alert resource, the standardalert function, and the standard alert
structure were introduced with Mac OS 8 and the Appearance Manager.

Regardless of which method is used to create the alert box, the standard note, caution,
and stop icons automatically appear in the upper-left corner of alert boxes displaying,
respectively, note, caution and stop alerts. When the alert function is used, or when a
plain alert is created using StandardAlert, no icon is displayed automatically, though you can
display your own icon.

'ALRT' and ‘alrx' Resources

When creating resources with Resorcerer, it is advisable that you refer to a diagram and
description of the structure of the resource and relate that to the various items in the
Resorcerer editing windows. Accordingly, the following describes the structure of the
resources associated with the creation of alert boxes.
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Structure of a Compiled 'ALRT' Resource

Fig 4 shows the structure of a compiled 'ALRT' resource.

BYTES
INITIAL RECTANGLE 8
ITEM LIST RESOURCE ID 2

ATH STAGE ALERT INFORMAT8N STAGE ALERT INFORMATION
2ND STAGE ALERT INFORMAM®NSTAGE ALERT INFORMATIONL
POSITIONING SPECIFICATION 2

FIG 4 - STRUCTURE OF A COMPILED ALERT ('ALRT’)

The following describes the fields of the 'ALRT' resource:

Field Description

INITIAL RECTANGLE A rectangle which determines the dimensions of the content region of
the alert box's window and, possibly, the position of the rectangle.
(The last field of the resource usually specifies a position for the alert.)

ITEM LIST RESOURCE ID The ID of the item list resource that specifies the items, such as press
buttons and static text, that are to be displayed in the alert box.

4TH STAGE ALERT Specifies the response when the user repeats the action that invokes

INFORMATION the alert four or more consecutive times. (See Alert Stages, below.)

3RD STAGE ALERT Specifies the response when the user repeats the action that invokes

INFORMATION the alert three consecutive times. (See Alert Stages, below.)

2ND STAGE ALERT Specifies the response when the user repeats the action that invokes

INFORMATION the alert two consecutive times. (See Alert Stages, below.)

15T STAGE ALERT Specifies the response for the first time the user invokes the action

INFORMATION that invokes the alert. (See Alert Stages, below.)

POSITIONING SPECIFICATION  Specifies the position of the alert box on the screen. If a positioning
constant is not provided, the Dialog Manager places the alert box at
the global coordinates you specify for the alert's rectangle. (See
Positioning Specification, below.)

Alert Stages

You can define different responses for each of the four alert stages. This is most
appropriate for stop alerts, that is, those which signify that an action cannot be
completed, especially when that action has a high probability of being accidental. In
such circumstances, you might specify that the system alert sound be played the first
time the user makes the mistake and, subsequently, that the alert box be displayed as
well. Note that every occurrence of the mistake after the fourth is treated as a fourth
stage alert.

As will be seen, for each of the four alert stages, you can specify whether the default ring
is drawn around the first or second push buttons in the alert, whether the alert box is to
be displayed, and whether the system alert sound is to be played one, two, or four times,
if at all.

Positioning Specification

The constants for the positioning specification field are as follows:

Constant Value Meaning
kWindowDefaultPosition 0x0000 Use initial location.
kWindowAlertPositionMainScreen 0x300A Alert position on main screen.
kWindowCenterParentWindow O0xA80A Centre on parent window.
kWindowAlertPositionParentWindow 0xBOOA Alert position on parent window.
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kWindowAlertPositionParentWindowScreen 0x700A Alert position on parent window
screen.

Structure of a Compiled 'alrx’' Resource

Fig 5 shows the structure of a compiled ‘alrx' resource. You use this resource to provide
additional features for your alert box, including movable modal behavior, theme-
compliant backgrounds and controls, and control embedding hierarchies.

BYTES
VERSION NUMBER 2
ALERT FLAGS 4
REFERENCE CONSTANT 4
WINDOW TYPE 1
RESERVED 1
e TITLE (MOVABLE ALERT ONLY) % 1TO 256

FIG 5 - STRUCTURE OF A COMPILED EXTENDBHIRESBRIR

The following describes the main fields of the ‘alrx' resource:

Field Description

ALERT FLAGS Constants specifying the alert box’s Appearance features. (See
Alert Feature Flag Constants, below).

REFERENCE CONSTANT Any value that an application wishes to store here. For example,

an application can store a number here that enables it to
distinguish between a number of similar alert boxes. Since this
information is stored in a window structure within the dialog
structure, you can use GetwRefCon to determine this value.

WINDOW TYPE If this Boolean is set to 1 (true), the Dialog Manager specifies an
Appearance-compliant window definition ID directly when drawing
the alert box window.

TITLE A string representing the title of a movable alert box

Alert Feature Flag Constants

You can set the following bits in the alert flags field of an ‘airx' resource to specify the
alert box's Appearance-compliant features:

Constant Bit Meaning

kAlertFlagsUseThemeBackground 0 If this bit is set, the Dialog Manager sets the alert box’s
background colour or pattern.

kAlertFlagsUseControlHierarchy 1 If this bit is set, the Dialog Manager creates a root

control in the alert box and establishes an embedding
hierarchy. All alert items automatically become
controls once the embedding hierarchy is established.

kAlertFlagsAlertlsMovable 2 If this bit is set, the alert box is movable modal. The
Dialog Manager handles movable modal behavior such
as dragging the alert box by its title bar or switching
out of the application by clicking in another one.

kAlertFlagsUseThemeControls 3 If this bit is set, the Dialog Manager creates
Appearance-compliant controls in the alert box.
Otherwise, push buttons, checkboxes, and radio buttons
will be displayed in their pre-Appearance forms when
system-wide Appearance is selected off.
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Creating 'ALRT' and 'alrx' Resources Using
Resourcer

Creating 'ALRT' Resources

Fig 6 shows an 'ALRT' resource being created with Resorcerer.

STRUCTURE OF A COMPILED ALERT ('ALRT') RESOURCE 157 STAGE: Outline item 1, do not display alert box, al
__ 2ND STAGE: Outline item 1, display alert box, alert sou

re— INITIAL RECTANGLE 3RD STAGE: Outline item 1, display alert box, alert sou
4TH STAGE: Outline item 1, display alert box, alert sou
ITEM LIST RESOURCE ID
e | ATH STAGE ALERT INFORMAIBQN STAGE ALERT INFORMAT o
== | 2ND STAGE ALERT INFORMA‘N@'NSTAGE ALERT INFORMAT | &
ALERT BOX POSITION
RESORCERER 'ALRT' RESOURCE EDITING WINDOW
= ALRT 128 “Alert” from MyApp.p.rsrc
Qutline Dutlln_e Suu_n[l_ I T ]
Stage  Item 1 item 2 Yisible uil 3
1: & ) L] Q®DQ | €
> 2 W ) 4| e L A€ L8 e
3 & ) | QO®OD |¢
> 4 L 2 (A 300 ®
 Xfrom [100 to |47 Width 375 Alerto.. v | €
“yirom [0 to |24 Height 144
DITL ID:
— Window Colors
128 &
Content: [ | trame: [ vve: [ ] N
Text: | Hitite: |
RGB: [ Cancel

FIG 6 - CREATING AN 'ALRT' RESOURCE USING RESORCERER

Creating 'alrx’' Resources
Fig 7 shows an ‘alrx' resource being created with Resorcerer. Note that the resource ID

of an 'alrx' resource must be the same as the resource ID of the 'ALRT' resource with which
it is associated.
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RESORCERER ‘'alrx' RESOURCE EDITING WINDOW

STRUCTURE OF A COMPILED =[0= alrx 128 “For Alert” from MyApp.p.rsrc =H5
EXTENDED ALERT ('alrx') RESOURCE
VERSION NUMBER b > Yersion 0O 1
4-21. Reserved 0 [ |
ALERT FLAGS =2 Use thaeme contrals [0On
> 2. Alert is movable On
1. Use control hierarchy On
REFERENCE CONSTANT 0. Use theme hackgruund on
> Reference constant 0
WINDOW TYPE > [¥] Window type Theme window=Trus
RESERVED Fillerr 0 _—
> Window title (movable only) “My Alert” | |
=~ TITLE (MOVABLE ALERT ONLY) <~ P_l_

FIG 7 - CREATING AN 'alrx' RESOURCE USING RESORCERER

The StandardAlert Function

When an alert box is created using the function standardalert, the alert box is automatically
sized based on the amount of text passed in to it, and push buttons are automatically

sized and located.

sounds.

StandardAlert does not provide for alert stages and corresponding alert

OSErr  StandardAlert(AlertType inAlertType,StringPtr inError,StringPtr inExplanation,
AlertStdAlertParamPtr inAlertParam,SInt16 *outltemHit);

Returns: A result code.

inAlertType

inError

inExplanation

inAlertParam

outltemHit

A constant indicating the type of alert box you wish to create (modal
or movable modal).

A pointer to a Pascal string containing the primary error (label) text
you wish to display.

A pointer to a Pascal string containing the secondary (narrative) text
you wish to display. Secondary text is displayed in the small system
font. Pass nuLL to indicate no secondary text.

A pointer to a standard alert structure (see below). Pass NuLL to
specify that you do not wish your alert box to incorporate any of the
features that the standard alert structure provides.

A pointer to an integer that, on output, will contain a value indicating
the item number of the push button that was hit.

Standard Alert Structure

The standard alert structure is as follows:

TYPE

AlertStdAlertParamRecPtr = ~AlertStdAlertParamRec;
AlertStdAlertParamRec = RECORD

movable:
helpButton:
filterProc:
defaultText:
cancelText:
otherText:
defaultButton:
cancelButton:
position:

END;
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BOOLEAN;
BOOLEAN;
ModalFilterUPP;
StringPtr;
StringPtr;
StringPtr;

SIntl16;

SInt16;

Uintle6;
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AlertStdAlertParamPtr = ~AlertStdAlertParamRec;

Field Descriptions
movable A Boolean value indicating whether or not the alert box is movable.
helpButton A Boolean value indicating whether or not the alert includes a Help button.
filterProc You may specify in this parameter a universal procedure pointer to an

defaultText

cancelText

otherText

defaultButton

cancelButton

position.

application-defined event filter function. If you set this parameter to nil,
the Dialog Manager uses the standard event filter function. (See Event
Filter Functions For Modal and Movable Modal Alert and Dialog Boxes,
below).

Text for the push button in the OK push button position. (See Alert Default
Text Constants, below). The push button automatically sizes and positions
itself in the alert box. To indicate that no push button should be displayed,
pass nil.

Text for the push button in the Cancel position. (See Alert Default Text
Constants, below.) The push button automatically sizes and positions itself
in the alert box. To indicate that no push button should be displayed, pass

nil.

Text for the push button in leftmost position. (See Alert Default Text
Constants, below.) The push button automatically sizes and positions itself
in the alert box. To indicate that no push button should be displayed, pass

nil.

Specifies which push button acts as the default push button. (See Alert
Button Constants, below.)

Specifies which push button acts as the Cancel push button. Can be 0. (See
Alert Button Constants, below.)

The alert box position, as defined by a window positioning specification.
(See Positioning Specification, above, but note that, in this structure, the
constant kWindowDefaultPosition is equivalent to
kWindowAlertPositionParentWindowScreen.)

Alert Default Text Constants

You can use these constants in the defaultText, cancelText, and otherText fields of the standard
alert structure to specify the default text for the OK, Cancel, and Don’t Save push buttons.

Constant

Value Meaning

kAlertDefaultOKText -1 The default text for the default (right) push button is “OK”

on an English system. The text will vary depending upon
the localisation of the user’s system. Use this constant in
the defaultText field of the standard alert structure.

kAlertDefaultCancelText -1 The default text for the Cancel (middle) push button is

“Cancel” on an English system. The text will vary
depending upon the localisation of your system. Use this
constant in the cancelText field of the standard alert
structure.

kAlertDefaultOtherText -1 The default text for the third (leftmost) push button is

“Don’t Save” for an English system. The text will vary
depending upon the localisation of the user’s system. Use
this constant in the otherText field of the standard alert
structure.
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Alert Push Button Constants

You can use these constants in the defaultButton and cancelButton fields in the standard alert
structure to specify which push buttons act as the default and Cancel push buttons in
the standard alert structure. These constants are also returned in the itemHit parameter of
StandardAlert.

Constant Value Meaning

kAlertStdAlertOKButton 1 The OK push button. The default text for this push
button is “OK”.

kAlertStdAlertCancelButton 2 The Cancel push button (optional). The default text for
this push button is “Cancel”.

kAlertStdAlertOtherButton 3 A third push button (optional). The default text for this
push button is “Don’t Save”.

kAlertStdAlertHelpButton 4 The Help push button (optional).

Creating Dialog Boxes

Dialog boxes may be created in one of two ways:

. Using the function GetNewDialog, which takes descriptive information about the dialog
from dialog ('DLoG') and extended dialog (‘digx') resources. The resource ID of the
'DLOG' and 'digx' resources must be the same, and is passed in the first parameter of
this function.

. Using Newbialog, NewColorDialog, O NewFeaturesDialog, which take descriptive information
passed in the parameters of those functions.

Historical Note

The extended dialog resource and the NewFeaturesDialog function were introduced with
OS 8 and the Appearance Manager. NewFeaturesDialog should be used to create
Appearance-compliant dialogs. Unlike NewbDialog and NewcColorDialog, it has a flags
parameter containing the same flags you would set in an extended dialog
resource.

If NnuLL is specified as the second parameter in the GetNewDialog call, GetNewbDialog itself
creates a non-relocatable block for the dialog structure. Passing NuLL is appropriate for
modal and movable modal dialog boxes because you should dispose of the dialog box, and
hence the associated dialog structure, when the user dismisses the dialog. However, in
order to avoid heap fragmentation effects, you should ordinarily allocate your own
memory for modeless dialog box dialog structures (just as you would for a window
structure) and specify the pointer to that memory block in the second parameter of the
GetNewDialog call.

Regardless of which method is used to create the dialog, a dialog structure and a
window structure will be created, and a pointer to the dialog structure will be returned
to the calling function.

The Dialog Structure

The dialog structure created by the GetNewDialog call is defined by the data type DialogRecord:

TYPE
DialogRecordPtr = ~DialogRecord;
DialogRecord = RECORD

window: WindowRecord;
items: Handle;

textH: TEHandle;
editField: SIntl6;
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editOpen: SInt16;
aDefltem: Sintl6;

END;

DialogPeek = ~DialogRecord;

Note that the dialog structure includes a window structure field. The Dialog Manager
sets the windowkind field of this window structure to kbialogwindowKind.

'DLOG' and 'digx' Resources

Structure of a Compiled 'DLOG’ Resource

Fig 8 shows the structure of a compiled 'DLOG' resource and how it "feeds" the dialog

structure.
BYTES
RECTANGLE 8
WINDOW DEFINITION ID 2
VISIBILITY 1
RESERVED 1 .
CLOSE BOX SPECIFICATION 1 DialogRecord = RECORD
RESERVED 1 window: WindowRecord;
items: Handle;
REFERENCE CONSTANT 4 textH:  TEHandle;
editField: SInt16;
editOpen: SIntl6;
ITEM LIST ID 2 aDefltem: SIntl6;
END;
% WINDOW TITLE % 1to 256
ALIGNMENT BYTE 1
POSITIONING SPECIFICATION 2

FIG 8 - STRUCTURE OF A COMPILED DIALOG (‘DLOG') RESOURCE

The following describes the main fields of the 'DLOG' resource:

Field

Description

RECTANGLE

Determines the dialog box's dimensions and, possibly, its position.
(The last field of the resource usually specifies a position for the dialog
box.)

WINDOW DEFINITION ID

The window definition ID. (See Window Types For Alerts and Dialogs,
above.)

VISIBILITY

If set to the the value of 1, the Dialog Manager displays this dialog box
as soon as you call the GetNewbialog function. If set to the value of 0, the
Dialog Manager does not display the dialog box until you call
ShowWindow.

CLOSE BOX SPECIFICATION

This specifies whether to draw a close box. Normally, this is set to the
value of 1 only for a modeless dialog box.

REFERENCE CONSTANT

Contains any value an application stores here. For example, an
application can store a number that represents a dialog box type, or it
can store a handle to a record that maintains state information about
the dialog box or other window types. An application can use the
SetWRefCon function to change this value and GetwRefCon to determine
the current value.

ITEM LIST ID

The resource ID of the item list resource associated with this dialog
box.

WINDOW TITLE

A Pascal string displayed in the dialog box's title bar (modeless and
movable modal dialog boxes only).

POSITIONING SPECIFICATION

Specifies the position of the dialog box on the screen. If a positioning
constant is not provided, the Dialog Manager places the dialog box at
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the global coordinates you specify for the dialog box's rectangle. The
same positioning constants as apply in the case of an alert box apply.
(See Positioning Specification, above.)

Structure of a Compiled 'digx’ Resource

Fig 9 shows the structure of a compiled 'digx’ resource. This resource allows you to
provide additional features for your dialog box, including movable modal behavior,
theme-compliant backgrounds and controls, and embedding hierarchies.

BYTES
VERSION NUMBER 2
DIALOG FLAGS 4

FIG 9 - STRUCTURE OF A COMPILED DIALOG ('dl

The following describes the main field of the 'digx' resource:

Field Description

DIALOG FLAGS Constants that specify the dialog box’s Appearance features. (See Dialog
Feature Flag Constants, below.)

Dialog Feature Flag Constants

You can set the following bits in the dialog flags field of a 'digx' resource to specify the
dialog box's Appearance-compliant features:

Constant Bit Meaning

kDialogFlagsUseThemeBackground 0 If this bit is set, the Dialog Manager sets the dialog
box’s background colour or pattern.

kDialogFlagsUseControlHierarchy 1 If this bit is set, the Dialog Manager creates a root

control in the dialog box and establishes an embedding
hierarchy. Any dialog items automatically become
controls once the embedding hierarchy is established.

kDialogFlagsHandleMovableModal 2 If this bit is set, the dialog box is movable modal (in
which case you must use kwindowMovableModalDialogProc
window definition ID). The Dialog Manager handles
movable modal behavior such as dragging the dialog
box by its title bar or switching out of the application by
clicking in another one.

kDialogFlagsUseThemeControls 3 If this bit is set, the Dialog Manager creates
Appearance-compliant controls in the dialog box
directly. Otherwise, push buttons, checkboxes, and
radio buttons will be displayed in their pre-Appearance
forms when system-wide Appearance is selected off.

Creating 'DLOG' and ‘digx ' Resources
Using Resorcerer

Creating 'digx’' Resources

Fig 10 shows a 'digx' resource being created with Resorcerer.
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Creating 'DLOG' Resources

RESORCERER "dIgx' RESOURCE EDITING WINDOW

=[01= dig= 128 “For Movable Modal Dialog® from by App.prst EEEI

STRUCTURE OF A COMPILED DIALOG ('digx') RE 4 Yersion 0O

VERSION NUMBER

DIALOG FLAGS

4
4-21. Reserved 0 [ |
=2 Use thaeme contrals [0On
N 2. Alert is movable On
4 1. Use control hierarchy On
0. Use theme background On =
(=
| Cancel

FIG 10 - CREATING A 'digx' RESOURCE USING RESORCERER

Fig 11 shows a 'DLOG' resource being created with Resorcerer.
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STRUCTURE OF A COMPILED DIALOG ('DLOG') RESOURCE

RECTANGLE

WINDOW DEFINITION ID

VISIBILITY —
RESERVED

CLOSE BOX SPECIFICATION
RESERVED

REFERENCE CONSTANT

ITEM LIST ID
e WINDOW TITLE =z
ALIGNMENT BYTE
POSITIONING SPECIFICATION
RESORCERER 'DLOG' RESOURCE EDITING WINDOW
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FIG 11 - CREATING A 'DLOG' RESOURCE USING RESORCERER

The NewFeaturesDialog Function

As previously stated, the function NewFeaturesDialog creates a dialog from the information
passed in its parameters.

FUNCTION NewFeaturesDialog(inStorage: UNIV Ptr; {CONST}VAR inBoundsRect: Rect;
inTitle: ConstStr255Param; inlsVisible: BOOLEAN; inProciD: SInt16;
inBehind: WindowPtr; inGoAwayFlag: BOOLEAN; inRefCon: SInt32;
inltemListHandle: Handle; inFlags: UInt32): DialogPtr;

Returns: A pointer to the new dialog box, or nil if the dialog box is not
created

inStorage A pointer to the memory for the dialog structure. If you set this
parameter to nil, the Dialog Manager automatically allocates a
nonrelocatable block in your application heap.

inBoundsRect A pointer to a rectangle, given in global coordinates, that
determines the size and position of the dialog box. These
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coordinates specify the upper-left and lower-right corners of the
dialog box.

inTitle A pointer to a text string used for the title of a modeless or movable
modal dialog box. You can specify an empty string? (not nil) for a
title bar that contains no text.

inlsVisible A flag that specifies whether the dialog box should be drawn on the
screen immediately. If you set this parameter to false, the dialog box
is not drawn until your application calls showwindow to display it.

inProciD The window definition ID for the type of dialog box. Use the
kWindowModalDialogProc constant to specify modal dialog boxes, the
kWindowMovableModalDialogProc constant to specify movable modal dialog
boxes, and the kwindowDocumentProc constant to specify modeless
dialog boxes.

inBehind A pointer to the window behind which the dialog box is to be placed
on the desktop. Set this parameter to the window pointer windowPtr(-
1) to bring the dialog box in front of all other windows.

inGoAwayFlag A Boolean value. If true, specifies that an active modeless dialog box
has a close box in its title bar.

inRefCon A value that the Dialog Manager uses to set the refcon field of the
dialog box’s window structure. Your application may store any
value here for any purpose. For example, your application can
store a number that represents a dialog box type, or it can store a
handle to a structure that maintains state information about the
dialog box. You can use the Window Manager function SetwRefCon to
change this value and GetwRefCon to determine its current value.

inltemListHandle A handle to an item list resource for the dialog box. You can get the
handle by calling GetResource to read the item list resource into
memory.

inFlags An unsigned 32-bit mask specifying the dialog box’s Appearance-
compliant feature flags. (See Dialog Feature Flag Constants,
above.)

Although the initemListHandle parameter specifies an item list ('DITL') resource for the dialog

box, the corresponding dialog font table (‘dftb') resource (see below) is not automatically
accessed. You must explicitly set the dialog box’s control font styles individually.

Items for Alert and Dialog Boxes

Preamble - Dialog Manager Primitives

Alert and dialog boxes contain items, such as push buttons, radio buttons, and
checkboxes. Prior to the introduction of Mac OS 8 and the Appearance Manager, an
actual control could be an item; however, items such as push buttons and radio buttons
were not controls as such but rather Dialog Manager primitives.

These primitives may still be specified in item list resources (see below). However,
under Appearance, when a root control has been created for the alert or dialog window,
thus creating an embedding hierarchy for controls, the Dialog Manager replaces any
primitives in the alert or dialog box with their control counterparts (except for the
primitive called a user item).

21n C, you specify an empty string by two double quotation marks ("").
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In the era of the Appearance Manager, the situation where all items in an alert or dialog
are controls has many advantages. For example, all controls within the alert or dialog
can be activated and deactivated by simply activating and deactivating the root control.
This includes edit text fields and static text fields. (It was previously not possible to
display the old edit text and static text primitives in the dimmed deactivated mode.)

The continued use of the Dialog Manager primitives is not inconsistent with the concept
of Appearance-compliant alert and dialog boxes provided that an embedding hierarchy
has been established, thus causing the Dialog Manager to replace the primitives with
(Appearance-compliant) controls.

The primitives, and their control equivalents, are as follows:

Dialog Manager Primitive Control Equivalent Comment

Button. Press button.

Radio Button. Radio button. Used in dialog boxes
only.

Checkbox. Checkbox. Used in dialog boxes
only.

Edit Text. Edit text field. Used in dialog boxes
only.

Static Text. Static text field.

Icon. (An icon whose black and Icon control (no track variant).

white resource was stored in an
'1coN' resource and whose colour
version is stored in a 'cicn' resource
with the same ID.)

Picture. (Picture stored in a 'picT Picture control (no track variant).

resource.)

User Item. (An application-defined Used in dialog boxes
item. For example, an application- only.

defined drawing function could be
installed in a user item.)

The 'DITL' Resource

You use an item list ('DITL') resource to store information about all the items in an alert or
dialog box. The 'DITL' resource ID is specified in the associated 'ALRT' or 'DLOG' resource.
'DITL' resources should be marked as purgeable.

Within a 'pDITL' resource for an alert box you can specify static text, button, icon and
picture primitives, or their control equivalents. In dialog boxes, any of the primitives,
and any control, may be specified.

Items are usually referred to by their position in the item list, that is, by their item
number.

Several independent dialog boxes may use the same 'DITL' resource. AppendDITL and
ShortenDITL may be used to modify or customise copies of a shared item list resources for
use in individual dialog boxes.

Fig 12 shows the structure of a compiled 'DITL' resource and one of its constituent items,
in this case a control item.
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FIG 12 - STRUCTURE OF A COMPILED ITEM LIST (‘DITL') RESOURCE AND A TYPI(

The following describes the fields of the 'DITL' resource and the control item:

Field Description

ITEM COUNT MINUS 1 This value is one less than the number of items defined in the resource.

IFTlFElf/IT ITEM ... LAST The format of each item depends on its type.

DISPLAY RECTANGLE  Determines the size and location of the item in the alert box or dialog box.
The rectangle is specified in coordinates local to the alert box or dialog box.
(See Display Rectangles, below.)

ENABLE FLAG Specifies whether the item is enabled or disabled. If this bit is set, the item
is enabled and the Dialog Manager reports to your application whenever a
mouse-down event occurs inside the item.

ITEM TYPE Specifies the item type.
RESOURCE ID For a control item, this is the resource ID of the 'cNTL' resource.
Display Rectangles

For controls, the item's display rectangle becomes the control's enclosing rectangle. To
match a control's enclosing rectangle to its own display rectangle, specify an enclosing
rectangle in the 'cNTL' resource identical to the display rectangle specified in the 'DITL
resource.** Other important aspects of display rectangles are as follows:

Edit Text Fields. For an edit text field, the display rectangle becomes the TextEdit
destination rectangle and view rectangle (see Chapter 19 — Text and TextEdit).
Word wrapping occurs within display rectangles that are large enough to contain
multiple lines of text, and the text is clipped if there is more text than will fit in the
rectangle.

Static Text Fields. For a static text field, the Dialog manager draws the text within
the display rectangle just as it draws edit text fields.

Icon and Picture Controls. For an icon or picture larger than the display rectangle,
the Dialog Manager scales the icon or picture to fit the display rectangle.

A click anywhere in the display rectangle is considered a click in that item.

Creating a 'DITL' Resource Using
Resorcerer

Fig 13 shows a 'DITL' resource being created with Resorcerer. Two items are being edited

(

Item 1 and Item 2). Item 1 is a Dialog Manager primitive. Item 2 is a control.

3 When an item is a control defined in a control resource, the rectangle added to the update region is the display rectangle
defined in the 'cNTL resource, not the display rectangle specified in the 'DITL' resource.

4 Resorcerer has a Preferences setting which forces conformity between the display rectangle specified in the 'DITL
resource and the display rectangle specified in the 'CNTL' resource.
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Layout Guidelines For Alert and Dialog Boxes

Layout guidelines for items in alert and dialog boxes are contained in the Apple
publication Mac OS 8 Human Interface Guidelines. These guidelines show, amongst
other things, the required spacing between items.

Default Push buttons

Default Push button in Alert Boxes

The first item in the item list for an alert box created using an 'ALRT' resource should
always be the Ok push button, because the Dialog Manager will then automatically draw
the default ring around that push button. This applies whether the item is a button
primitive or a push button control. If a Cancel push button is required, it should be the
second item.

Default Push button in Dialog Boxes

You should give every dialog a default push button, except for those which contain edit
text fields that accept Return key presses. If you do not provide an event filter function
(see Event Filter Functions For Modal and Movable Modal Alert and Dialog Boxes,
below) which specifies otherwise, the Dialog Manager treats the first item in the item list
resource as the default push button for the purpose of responding to Return and Enter
key presses.

The Dialog Manager does not automatically draw the default ring around the default
push button in dialog boxes.

Enabling and Disabling Items

You should not necessarily enable all items. For example, you typically disable static text
field items and edit text field items because your application does not need to respond to
clicks in those items.

Do not confuse a disabled item with a deactivated control. When a control is deactivated,
the Control Manager dims it to show that it is deactivated. The Dialog Manager makes
no visual distinction between a disabled and enabled item; it simply does not inform your
application when the user clicks a disabled item.

Keyboard Focus

Edit text fields and clock controls accept input from the keyboard, and list boxes respond
to certain key presses. The Dialog Manager automatically responds to mouse-down
events and Tab key-down events intended to shift the keyboard focus between such
items, indicating the current target by drawing a keyboard focus frame around that item.
For edit text fields, the Dialog Manager also automatically displays the insertion point
caret in the current target. For clock controls, the Dialog Manager, in addition to
drawing the keyboard focus frame, also moves the keyboard target within the clock by
highlighting the individual parts.

The Tab key moves the keyboard focus between such items in a sequence determined by
their order in the item list. Accordingly, you should ensure that the item numbers of
these items in the 'DITL' resource reflect the sequence in which you require them to be
selected by successive Tab key presses.
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Manipulating Items

Functions for Manipulating Items

Dialog Manager functions for manipulating items are as follows. Those introduced with
Mac OS 8 and the Appearance Manager are shown against a gray background.

Function
GetDialogltemAsControl

Description

Returns the control handle for an item in an embedding hierarchy.
Should be used instead of GetbDialogitem (see below) when an embedding
hierarchy is established.

Returns the the control handle (or, for application-defined draw
functions, the function pointer), item type, and display rectangle of a
given item. When an embedding hierarchy is present, you should
generally use GetDialogltemAsControl instead of GetDialogitem to get a handle to
the control.

When called on a static text field item, Getbialogitem returns a handle to
the text, not to the control, and thus may still be used to get a handle to
the text of static text fields. (When called on a static text field item,
GetDialogltemAsControl returns a handle to the control, not to the text.)

When an embedding hierarchy does not exist, sets the item type and

the display rectangle of an item or, for application-defined items, the

draw function of an item.

When an embedding hierarchy exists, you cannot change the type or

handle of an item, but application-defined item drawing functions can
still be set.

GetDialogltem

SetDialogltem

HideDialogltem

Hides the given item.

ShowDialogltem

Re-displays a hidden item.

GetDialogltemText

Returns the text of an edit or static text field item.

SelectDialogltemText

Selects the text of an edit text field item. When embedding is on, you
should pass in the control handle produced by a call to
GetDialogltemAsControl. When embedding is not on, you should pass in the
handle produced by a call to Getbialogitem.

FindDialogltem

Determines the item number of an item at a particular location in a
dialog box.

MoveDialogltem

Moves a dialog item to a specified location in a window. Ensures that,
if the item is a control, the control rectangle and the dialog item
rectangle (maintained by the Dialog Manager) are always the same.

SizeDialogltem

Resizes a dialog item to a specified size. If the dialog item is a control,
the control rectangle and the dialog item rectangle (maintained by the
Dialog Manager) are always the same.

CountDITL Counts items in a dialog box.

AppendDITL Adds items to a dialog box. (See Append Method Constants, below.)
ShortenDITL Removes items from a dialog box.

ParamText

Substitutes up to four different text strings in static text field items.

GetAlertStage

Returns the stage of the last occurrence of an alert.

ResetAlertStage

Resets the stage of the last occurrence of an alert.

Append Method Constants

The AppendDITL and shortenDITL functions are especially useful where several dialog boxes
share the same 'DITL' resource and you want to add or remove items as appropriate for
individual dialog boxes. When you call AppendDITL , you specify a new 'DITL' resource to
append to the dialog box's existing 'DITL' resource. You also specify where the Dialog
Manager should display the new items by using one of the following constants in the
AppendDITL call:

Constant Value Description
overlay 0 Overlay existing items. Coordinates of the display rectangle are
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interpreted as local coordinates within the dialog box.

AppendDITLRight 1 Append at right. Display rectangles are interpreted as relative to
the upper-right coordinate of the dialog box.
appendDITLBottom 2 Append at bottom. Display rectangles are interpreted as relative

to the lower-left coordinate of the dialog box.

As an alternative to passing these constants, you can pass a negative number to
AppendDITL, which appends the items relative to an existing item in the dialog box. The
absolute value of this number is interpreted as the item in the dialog box relative to
which the new items are to be positioned. For example, -2 would cause the display
rectangles of the appended items to be offset from the upper-left corner of item number
2 in the dialog box.

AppendDITL modifies the contents of the dialog box (for instance, by enlarging it). To use
the unmodified version of the dialog box at a later time, you should call ReleaseResource to
release the memory occupied by the appended item list.

Getting and Setting The Text in EditText
Field and Static Text Field Items

Dialog Manager functions for getting text from, and setting the text of, edit text field and
static text field items are as follows:

Function Description

GetDialogltemText Gets a copy of the text in static text field and edit text field items. Pass in
the handle produced by a call to Getbialogitem, which gets a handle the text in
this instance, not to the control.

SetDialogltemText Sets the text string for static text and edit text fields. When embedding is
on, you should pass in the control handle produced by a call to
GetDialogltemAsControl. If embedding is not on, pass in the handle produced by
GetDialogltem.

The function paramText may also be used to set the text string in a static text field in an
alert box or dialog box. A common example is the inclusion of the window title in static
text such as "Save changes to the document ... before closing?". In this case, the window's title
could be retrieved using GetwTite and inserted by paramText at the appropriate text
replacement variable (~0, ~1, ~2 or ~3) specified in the static text field item in the 'DITL
resource.

Since there are four text replacement variables, pParamText can supply up to four text
strings for a single alert or dialog box.

Setting the Font For Controls in an Alert or Dialog Box — 'dftb’' Resources

When an embedding hierarchy is established in a dialog box, you can specify the initial
font settings for all controls in an alert or dialog box by creating a dialog font table
resource (resource type 'dftb’) with the same resource ID as the alert or dialog's 'DITL
resource. When a 'dftb' resource is read in, the control font styles are set, and the
resource is marked purgeable.

The ‘'dfto’ resource is the resource-based equivalent of the programmatic method of
setting a control's font using the function SsetControlFontstyle described at Chapter 7 —
Introduction To Controls.

Structure of a Compiled 'dftb' Resource

Fig 14 shows the structure of a compiled 'dftb' resource and of a constituent dialog font
table entry.
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The following describes the main fields of the 'dftb' resource and the dialog control font
entry:

Field Description

NUMBER OF An integer that specifies the number of entries in the resource. Each entry is

ENTRIES a dialog control font structure.

FIRST DIALOG A series of dialog control font structures, each of which consist of type, dialog

E%\E\F‘OL FONT font flags, the font ID, font size, font style, text mode, justification, text color,

LASTDIALOG background color, and font name.

CONTROL FONT

ENTRY

TYPE An integer that specifies whether there is font information for the dialog or
alert item in the 'piTL'. If you specify a value of o, there is no font information
for the item in the corresponding 'piTL', and no data follows. If you specify a
value of 1, there is font information for the item, and the rest of the structure
is read. You can cause entries to be skipped by setting this value to o.

DIALOG FONT You can use one or more of these flag constants to specify which other fields

FLAGS in the dialog font table should be used. (See Dialog Font Flag Constants,
below.)

FONT ID If the kbialogFontuseFontMask bit is set to 1, then this element will contain an

integer indicating the ID of the font family to use. (See Meta Font Constants,
below, for more information about the constants that you can specify.) If this
bit is set to o, then the system default font is used.

FONT SIZE If a constant representing the system font, small system font, or small
emphasized system font is specified in the Font ID field, this field is ignored.
If the kDialogFontusesizeMask bit is set, this field should contain an integer
representing the point size of the text. If the kbialogFontaddsizeMask bit is set, this
value will contain the size to add to the current point size of the text.

STYLE If the kDialogFontUseFaceMask bit is set, then this element should contain an integer
specifying the text style to describe which styles to apply to the text. You can
use one or more of the following style data type mask constants to specify

font style:

Bit Value Style

$00 Normal
$01 Bold

$02 Italic

$04 Underline
$08 Outline
$10 Shadow
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$20 Condense
$40 Extend

TEXT MODE If the kpialogFontuseModeMask bit is set, then this element should contain an integer
specifying how characters are drawn. (See Chapter 12 — Drawing With
QuickDraw for a discussion of transfer modes.)

JUSTIFICATION If the kpialogFontUsejustMask bit is set, then this element should contain an integer
specifying text justification (left, right, centered, or system-justified).

TEXT COLOR If the kpialoguseFontForeColorMask bit is set, then this element should contain a
colour to use when drawing the text.

ggfg(;ROUND If the kbialogFontuseBackColorMask bit is set, then this element should contain a

colour to use when drawing the background behind the text. In certain text
modes, background colour is ignored.

FONT NAME If the kDialogFontUseFontNameMask bit is set, then this element should contain a
Pascal string representing the font name to be used. This overrides the font
ID.

Dialog Font Flag Constants

You can set the following bits in the the dialog font flags field of a dialog control font
entry to specify the fields in the entry that should be used

Constant Value Meaning

kDialogFontNoFontStyle $0000  No font style information is applied.

kDialogFontUseFontMask $0001  The font ID specified in the Font ID field of the dialog
font table is applied.

kDialogFontUseFaceMask $0002  The font style specified in the Style field of the dialog
font table is applied.

kDialogFontUseSizeMask $0004  The font size specified in the Font Size field of the
dialog font table is applied.

kDialogFontUseForeColorMask $0008  The text color specified in the Text Color field of the

dialog font table is applied. This flag only applies to
static text controls.

kDialogFontUseBackColorMask $0010  The background color specified in the Background
Color field of the dialog font table is applied. This flag
only applies to static text controls.

kDialogFontUseModeMask $0020  The text mode specified in the Text Mode field of the
dialog font table is applied.

kDialogFontUseJustMask $0040  The text justification specified in the Justification field
of the dialog font table is applied.

kDialogFontUseAllMask $00FF  All flags in this mask will be set except
kDialogFontAddFontSizeMask and kDialogFontUseFontNameMask.

kDialogFontAddFontSizeMask $0100  The Dialog Manager will add a specified font size to the

existing font size indicated in the Font Size field of the
dialog font table resource.

kDialogFontUseFontNameMask $0200  The Dialog Manager will use the string in the Font
Name field for the font name instead of a font ID.

Meta Font Constants

You can use the following meta font constants in the font ID field of a dialog control font
entry to specify to specify the style, size, and font family of a control's font. You should
use these meta font constants whenever possible because the system font can change,
depending upon the current theme. If none of these constants are specified, the control
uses the system font unless a control with a variant that uses the window font has been
specified.

Constant Value Meaning In Roman Script System

kControlFontBigSystemFont $0001  Use the system font. (For the Roman script system,
this is Charcoal 12.)
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kControlFontSmallSystemFont $0002 Use the small system font. (For the Roman script
system, this is Geneva 10.)
kControlFontSmallBoldSystemFont $0004  Use the small emphasized system font. (For the

Roman script system, this is Geneva 10.)

Another advantage of using these meta font constants is that you can be sure of getting
the correct font on a Macintosh using a different script system, such as kanji.

Historical Note

Prior to the introduction of Mac OS 8 and the Appearance Manager, icon colour
table ('ictb') resources were used to specify the colour, typface, font style, and font
size for items in an alert or dialog box. When an embedding hierarchy is present,
the 'ictb' resource is ignored.

Creating a 'dftb’' Resource Using Resorcerer

Fig 15 shows a dialog control font entry in a 'dftb' resource being edited with Resorcerer.

=[LI== dftb 1231 "For Modeless Dialog® from My dpp.ursre ==[E]=
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FIG 15 - CREATING A 'dftb' RESOURCE USING RESORCERER
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Displaying Alert and Dialog Boxes

As previously stated:

Alert, NoteAlert, CautionAlert and StopAlert are used to create and display alert boxes using
descriptive information supplied by 'ALRT' and ‘alrx' resources, and StandardAlert is used,
in conjunction with information suppled by a standard alert structure, to create and
display alert boxes programmatically.

GetNewDialog is used to create dialog boxes using descriptive information supplied by
'DLOG' and ‘'digx'’ resources, and NewFeaturesDialog is used to create dialog boxes
programmatically. Both creation methods allow you to specify whether the dialog
box is to be initially visible, and both allow you to specify whether or not the dialog
box is to be brought to the front of all other windows when it is opened.

To display a dialog box which is specified to be invisible on creation, you must call
ShowWindow following the GetNewDialog Or NewFeaturesDialog call to display the dialog box. In
addition, you should invariably pass windowptr(-1) in the behind and inBehind and parameters
of, respectively, GetNewbDialog and NewFeaturesDialog call so as to display a dialog box as the
active (frontmost) window.

Window Deactivation and Menu Adjustment

When an alert box or dialog box is displayed:

The frontmost window (assuming one exists) must be deactivated.

The application's menus must be adjusted to reflect the differing levels of
permitted menu access which apply in the presence of the various types of alert
box and dialog box. (As will be seen, the system software automatically performs
some of this menu adjustment for you.)

Historical Note

Prior to the introduction of Mac OS 8 and the Appearance Manager, window
deactivation when a movable modal dialog box was displayed was handled in the
same way as applies in the case of a modeless dialog box, that is, within the
application's main event loop. However, under Appearance, when the
kDialogFlagsHandleMovableModal bit is set in the 'digx' resource, or in the infFlags parameter of
NewFeaturesDialog, ModalDialog iS used to handle all user interaction within the dialog.
(Previously, this user interaction was handled within the main event loop.) This
has implications for the way your application deactivates the front window when a
movable modal dialog is displayed.

Prior to the introduction of Mac OS 8 and the Appearance Manager, menu
adjustment when a movable modal dialog box was displayed was performed by the
application. However, when a movable modal dialog is created by setting the
kDialogFlagsHandleMovableModal bit in the ‘'digx’ resource, or in the infFlags parameter of
NewFeaturesDialog, menu adjusment is performed by the Dialog Manager and Menu
Manager.

All that follows assumes that the kbialogFlagsHandleMovableModal bit is set in the ‘digx’
resource, or in the inFlags parameter of NewFeaturesbialog, and that, as a consequence:

* Your application calls ModalDialog to handle all user interaction within movable
modal dialog boxes (as is the case with modal dialog boxes).

* Menu adjustment will be performed automatically by the Dialog Manager and
Menu Manager when a movable modal dialog is displayed (as is the case with
modal dialog boxes).
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Window Deactivation — Modeless Dialog
Boxes

You do not have to deactivate the front window explicitly when displaying a modeless
dialog box. The Event Manager continues sending your application activate events for
your windows as needed, which you typically handle in your main event loop.

Window Deactivation — Modal and Movable
Modal Alert and Dialog Boxes

When a modal or movable modal dialog box is created and displayed, your application
calls ModalDialog to handle all user interaction within the dialog until the dialog is
dismissed. Events, which are ordinarily handled within your application's main event
loop, will then be trapped and handled by Modalbialog. This means that your window
activation/deactivation function will not now be called as it normally would following the
opening of a new window. Accordingly, if one of your application's windows is active,
you must explicitly deactivate it before displaying a modal or movable modal alert or
dialog box.

If your application does not display an alert box during certain alert stages, you should
call the GetAirtstage function to test for those stages before deactivating the active window.

Menu Adjustment — Modeless Dialog Boxes

When your application displays a modeless dialog box, it is responsible for all menu
disabling and enabling. Your application should thus perform the following tasks:

. Disable only those menus whose items are invalid in the current context.

. If the modeless dialog box includes edit text fields, enable the Edit menu and use
the Dialog Manager functions DialogCut, DialogCopy, DialogPaste and DialogDelete t0 support
the Cut, Copy, Paste, and Clear items in that menu.

Your application is also responsible for all menu enabling when a modeless dialog box is
dismissed.

Menu Adjustment — Modal Alert and Dialog
Boxes

When your application displays a modal alert or dialog box, the Dialog Manager and
Menu Manager interact to provide varying degrees of access to the menus in your menu
bar, as follows:

. System software disables the Application menu, and all items in the Help menu
except the Show Balloons/Hide Balloons item.

. The Dialog Manager determines whether any of the following cases is true:
. Your application does not have an Apple menu.
. Your application does have an Apple menu, but the menu is currently
disabled.
. Your application has an Apple menu, but the first item in that menu is

currently disabled.
If none of these cases is true, system software behaves as follows:

. The Menu Manager disables all your application's menus.
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. If the modal dialog box contains a visible and active edit text field, and if the
menu bar contains a menu having items with the standard keyboard
equivalents for Cut, Copy and Paste, the Menu Manager enables that menu and
those three items.

Modal Dialog Boxes with Edit Text Field Items

When your application displays modal dialog boxes with no edit text field items, it can
safely allow system software to handle menu bar access. However, because system
software cannot handle the Undo and Clear commands (or any other context-dependent
command), you may wish to handle your own menu bar access for modal dialog boxes
with edit text field items by performing the following tasks:

. Disable the Apple menu or its first item (typically, the About... item) in order to take
control of menu bar access away from the Dialog Manager.

. Disable all of the application's menus except the Edit menu, as well as any
inappropriate items in the Edit menu.

. Use DialogCut, DialogCopy, DialogPaste, and DialogDelete to support the Cut, Copy, Paste, and
Clear items in edit text fields.

. Provide your own code for supporting the Undo item.
. Enable your application's items in the Help menu as appropriate.
When the user dismisses the modal alert or dialog box, the Menu Manager restores all

menus to their previous state unless your application handles its own menu bar access, in
which case your application must restore the menu bar to its previous state.

Menu Adjustment — Movable Modal Alert
and Dialog Boxes

When your application displays a movable modal alert or dialog box, the Dialog Manager
and Menu Manager interact to provide the same access to the menus in your menu bar
as applies in the case of modal alert and dialog boxes except that, in this case, the Help
and Application menus are enabled.

The alternative of taking control of menu bar access from the Dialog Manager where the
dialog box contain edit text field items also applies in the case of movable modal dialogs.

When the user dismisses the movable modal alert or dialog box, the Menu Manager
restores all menus to their previous state unless your application handles its own menu
bar access, in which case your application must restore the menu bar to its previous
state.

Displaying Multiple Alert and Dialog Boxes

The user should never see more than one modal dialog box and one modal alert box on
the screen simultaneously. However, you can present multiple simultaneous modeless
dialog boxes just as you can present multiple document windows.

Resizing a Dialog

You can use the function AutoSizeDialog to automatically resize static text fields and their
dialog boxes to accommodate changed static text. For each static text field item found,
AutoSizeDialog adjusts the static text field and the bottom of the dialog box window. Any
items below a static text field are moved down. If the dialog box is visible, when
AutoSizeDialog is called, it is hidden, resized, and then shown.

8-30 Dialogs and Alerts



Displaying Alert and Dialog Boxes From the Background

If you ever need to display a modal alert or dialog box while your application is running
in the background or is otherwise invisible to the user, you should use the Notification
Manager to post a notification to the user. The Notification Manager automatically
displays an alert box containing whatever message you specify; you do not need to use
the Dialog Manager to create the alert yourself. (See Chapter 23 — Miscellany for a
description of the Notification Manager).

Handling Events in Alert and Dialog Boxes

Overview

Modal and Movable Modal Alert and Dialog
Boxes

When Alert, NoteAlert, CautionAlert, StopAlert, and StandardAlert are used to display alert boxes, the
Dialog Manager handles all of the events generated by the user until the user clicks a
push button. (These functions are actually just variations of ModalDialog which create and
destroy their own windows.) When the user hits a push button, these functions highlight
the push button briefly, close the alert box and report the user's selection to the
application.

As previously stated, ModalDialog handles all user interaction within modal and movable
modal dialogs. When the user selects an enabled item, ModalDialog reports that the user
selected the item and then exits. Your application is then responsible for performing the
appropriate action in relation to that item. Your application typically calls ModalDialog
repeatedly until the user dismisses the dialog.

The modalFilter parameters in the Alert, NoteAlert, CautionAlert, StopAlert, StandardAlert and ModalDialog
functions, and the filterproc field of the standard alert structure associated with the
standardAlert function, take a universal procedure pointer to an event filter function. The
Dialog Manager provides a standard event filter function, which is used if nil is passed
in the modalFilter parameter or filterProc field; however, you should supply an application-
defined event filter function for modal and movable modal alert and dialog boxes so as to
avoid a basic limitation of the standard event filter function. (See Event Filter Functions
For Modal and Movable Modal Alert and Dialog Boxes, below)

Modeless Dialog Boxes

For modeless dialog boxes, you can use the function Isbialogevent to determine whether the
event occurred while a modeless dialog box was the frontmost window and then,
optionally, use the function DbialogSelect to handle the event if it belongs to a modeless
dialog box. DialogSelect is similar to ModalDialog except that it returns control after every
event, not just events relating to an enabled item. Also, DialogSelect does not pass events to
an event filter function.

Responding to Events in Controls

Controls and Control Values

For clicks in those types types of controls for which you need to determine or change the
control's value, your application should use the Control Manager functions GetControlvalue
and setControlvalue to get and set the value. When the user clicks on the OK push button,
your application should perform whatever action is necessary according to the values
returned by the controls.
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Controls That Accept Keyboard Input

Edit text fields and clock controls, which both accept keyboard input, are typically
disabled because you generally do not need to be informed every time the user clicks on
one of them or types a character. Instead, you simply need to retrieve the text in the edit
text field control, or the clock's date/time value, when the user clicks the OK push button.

When you use ModalDialog (key-down events in edit text fields and clock controls in modal
or movable modal dialogs) or DialogSelect (key-down events in edit text fields and clock
controls in modeless dialogs), keystrokes and mouse actions within those controls are
handled automatically. In the case of an edit text field, this means that:

. When the user clicks the item, a blinking vertical bar, called the insertion point
caret, appears.

. When the user drags over text or double-clicks a word, that text is highlighted and
replaced by whatever the user types.

. When the user holds down the Shift key while clicking and dragging, the
highlighted section is extended or shortened appropriately.

. When the user presses the backspace key, the highlighted selection or the
character preceding the insertion point is deleted.

. When the user presses the Tab key, the cursor and keyboard focus frame
automatically advances to the next edit text field, clock control, or list box (if any)
in the item list, wrapping around to the first one if there are no more items.

Caret Blinking in Edit Text Fields

ModalDialog Will cause the the insertion point caret to blink in edit text fields in modal and
movable modal dialog boxes. For edit text fields in a modeless dialog box, you should call
IdleControls in your main event loop's idle processing function. IdleControls calls the edit text
field control with an idle event so that the control can call TEidle to make the insertion
point caret blink. *

Historical Note

IdleControl, and idle processing within certain control definition functions, was
introduced with Mac OS 8 and the Appearance Manager. Prior to the introduction
of Mac OS 8 and the Appearance Manager, the method used to cause the insertion
point caret to blink in a modeless dialog was to call DialogSelect in the main event
loop's idle processing function. DialogSelect calls TEidle to make the caret blink. This
method remains a valid alternative.

Responding to Events in Modal and Movable Modal Alert Boxes

After displaying a modal or movable modal alert box, Alert, NoteAlert, CautionAlert, StopAlert, and
StandardAlert call ModalDialog to handle events automatically.

If the event is a mouse-down anywhere outside the content region of a modal alert box,
ModalDialog emits the system alert sound and gets the next event.

If the event is a mouse-down outside the content region of a movable modal alert box and
within a window belonging to the application, ModalDialog emits the system alert sound and
gets the next event. If the mouse-down is not within the content region or a window
belonging to the application, ModalDialog performs alert box dragging (if the mouse-down is

5 You should also ensure that, when caret blinking is required, the sleep parameter in the waitNextEvent call is set to a value
no greater that that returned by GetCaretTime.
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within the title bar) or sends the application to the background (if the mouse-down is not
within the title bar).

ModalDialog is continually called until the user selects an enabled control, at which time
Alert, NoteAlert, CautionAlert, StopAlert, and StandardAlert remove the alert box from the screen and
return the item number of the selected control. Your application then should then
respond appropriately.

The standard event filter function allows users to press the Return or Enter key in lieu of
clicking the default push button. When you write your own event filter function, you
should ensure that that function retains this behaviour. For events inside the alert box,
ModalDialog passes the event to your event filter function before handling the event. Your
event filter function thus provides a means to:

. Handle events which ModalDialog does not handle.
. Override events ModalDialog would otherwise handle.

Unless your event filter function handles the event in its own way, ModalDialog handles the
event inside the alert box as follows:

. In response to an activate or update event for the alert box, ModalDialog activates or
updates the alert box window.

. If the user presses the mouse button while the cursor is in a trackable control,
TrackControl is called to track the mouse. If the user releases the mouse button while
the cursor is still in the control, the alert box is removed and the control's item
number is returned.

. If the user presses the mouse button while the cursor is in a disabled item, or if it is
in no item, or if any other event occurs, nothing happens.

Responding To Events in Modal and Movable Modal Dialog Boxes

Your application should call Modalbialog immediately after displaying a modal or movable
modal dialog box. ModalDialog repeatedly handles events inside the dialog box until an
event involving an enabled item occurs, at which time ModalDialog exits, returning the item
number. Your application should then respond appropriately. Your application should
continually call Modalbialog until the user clicks on the OK or Cancel push button, at which
time your application should close the dialog box.

If the event is a mouse-down anywhere outside the content region of a modal dialog box,
ModalDialog emits the system alert sound and gets the next event.

If the event is a mouse-down outside the content region of a movable modal dialog box
and within a window belonging to the application, ModalDialog emits the system alert sound
and gets the next event. If the mouse down is not within the content region or a window
belonging to the application, ModalDialog performs dialog box dragging (if the mouse-down
is within the title bar) or sends the application to the background (if the mouse-down is
not within the title bar).

If your event filter function does not handle the event, ModalDialog handles the event as
follows:

. If the event is an activate or update event for the dialog box, ModalDialog activates or
updates the dialog box window.

. If the event is a mouse-down while the cursor is in a control that accepts keyboard
input (that is, an edit text field or a clock control), ModalDialog responds to the mouse
activity as appropriate, that is, by either displaying an insertion point or by
selecting text in an edit text field or by highlighting the appropriate part of the
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clock control. Where there is more than one control that accepts keyboard input,
ModalDialog moves the keyboard focus to that control. If a key-down event occurs and
there is an edit text field in the dialog, ModalDialog uses TextEdit to handle text entry
and editing automatically. If the edit text field is enabled, ModalDialog returns its item
number after it receives either the mouse-down or key-down event. (Normally, edit
text fields are disabled, and you use the GetDialogitemText function to read the
information in the items only after the user clicks the OK button.)

. If the event is a mouse-down while the cursor is in a trackable control, ModalDialog
calls the Control Manager function TrackControl. If the user releases the mouse
button while the cursor is in an enabled control, mModalDialog returns the control’s
item number. Your application should then respond appropriately.

. If the event is a Tab key key-down event and there is more than one control that
accepts keyboard input, ModalDialog moves the keyboard focus to the next such item
in the item list.

. If the event is a mouse-down while the cursor is in a disabled item or in no item, or
if any other event occurs, ModalDialog does nothing.

Specifying the Events To Be Received by
ModalDialog

The function setModalDialogEventMask may be used to specify the events to be received by the
ModalDialog function for a given modal or movable modal dialog box. This allows your
application to specify additional events that are not by default received by ModalDialog,
such as disk-inserted events and operating system events. If you us this function to
change the ModalDialog function's event mask, you must pass ModalDialog a pointer to your
own event filter function to handle the added events.

You can ascertain the events to be received by ModalDialog by calling GetModalDialogEventMask.

Historical Note

SetModalDialogEventMask and GetDialogEventMask were introduced with Mac OS 8.5.

Simulating Item Selection

You can cause the Dialog Manager to simulate item selection in a modal or movable
modal dialog box using the function SetDialogTimeout. Your application calls this function
each time you wish to start a countdown for a specified duration for a specified dialog
box. When the specified time elapses, the Dialog Manager simulates a click on the
button specified in the setDialogTimeout call. The Dialog Manager will not simulate item
selection until ModalDialog processes an event.

You can ascertain the original countdown duration, the time remaining, and the item
selection to be simulated by calling GetDialogTimeout.

Historical Note

SetDialogTimeout and GetDialogTimeout were introduced with Mac OS 8.5.

Event Filter Functions For Modal and Movable Modal Alert and Dialog
Boxes

In early versions of the system software, when a single application controlled the
computer, the standard event filter for the (modal) alert and modal dialog boxes of the
day was usually sufficient. However, because the standard event filter does not cater for
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the updating of either the parent application's windows or those belonging to background
applications, it has long been inadequate. Your application should therefore provide an
event filter function which compensates for this inadequacy. In most cases, you can use
the same filter function for all of your modal and movable modal alert and dialog boxes.

The standard event filter function performs the following checks and actions:

. Checks whether the user has pressed the Return or Enter key and, if so, highlights
the default push button for eight ticks and returns the item number of that push
button.s

. For dialog boxes only, and only if the application has previously called certain
Dialog Manager functions (see below):

. Checks whether the user has pressed the Escape key or Command-period
and, if so, highlights the Cancel push button for eight ticks and returns the
item number of that button.

. Check whether the cursor is over an edit text field and, if so, changes the
cursor shape to the I-Beam cursor.

As a minimum, your application-defined event filter function should ensure that these
checks and actions are performed and should also:

. Handle update events not belonging to the alert or dialog box so as to allow the
application to update its own windows, and return false. (Note that, by responding
to update events in the application's own windows in this way, you also allow
ModalDialog to perform a minor switch when necessary so that background
applications can update their windows as well.)

. Return false for all events that your event filter function does not handle.

Defining an Event Filter Function

Part of the recommended approach to defining a basic event filter function is to continue
to use the standard event filter function to perform its checks and actions as described
above. This requires certain preliminary action which, for dialog boxes, requires calls
similar to the following examples after the dialog is created and before the call to
ModalDialog:

{ Tell the Dialog Manager which is the default push button item, alias the Return and
Enter keys to that item, and draw the default ring around that item. }

ignoredOSErr := SetDialogDefaultltem(myDialogPtr, iOK);

{ Tell the Dialog Manager which is the Cancel push button item, and alias the escape
key and Command-period key presses to that item. }

ignoredOSErr := SetDialogCancelltem(myDialogPtr, iCancel);

{ Tell the Dialog Manager to track the cursor and change it to the I-Beam cursor shape
whenever it is over an edit text field. }

ignoredOSErr := SetDialogTracksCursor(myDialogPtr, true);

Note that, for all this to work, it is essential that default and Cancel push buttons, and edit
text fields, be specified as primitives, not as actual controls, in the 'DLOG' resource.

With those preparations made, you would define your basic event filter function as in the
following example:

6 Unless informed otherwise, the Dialog Manager assumes that the first item in the item list is the default push button. As
will be seen, it is possible to specify another push button as the default push button in dialog boxes; however, changing the
default push button in alert boxes is possible only when the alert box is created using StandardAlert. This is why the default
push button in an 'ALRT' resource must be the first item in the item list.
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function EventFilter(theDialogPtr : DialogPtr; {const} var theEvent : EventRecord;
var itemHit : SIntl6) : boolean;
var
handledEvent : boolean;;
oldPort : GrafPtr;

begin
handledEvent := false;

if ((theEvent.what = updateEvt) and
(WindowPtr(theEvent.message) <> theDialogPtr)) then
begin
{ If the event is an update event, and if it is not for the dialog or alert, call
your application's window updating function, and return false. }

DoUpdate(theEvent);
end
else begin
{ If the event was not an update, first save the current graphics port and set the
alert box or dialog box's graphics port as the current graphics port. This is
necessary when you have called SetDialogTrackCursor to cause the Dialog Manager
to track cursor position. }

GetPort(oldPort);
SetPort(theDialogPtr);

{ Pass the event to the standard event filter function for handling. If the
function handles the event, it will return true and, in the itemHit parameter,
the number of the item that it handled. ModalDialog, Alert, NoteAlert,
CautionAlert, StopAlert, and StandardAlert then return this item number in their
own itemHit parameter. }

handledEvent := StdFilterProc(theDialogPtr, theEvent, itemHit);

{ Make the saved graphics port the current graphics port again. }

SetPort(oldPort);
end;

{ Return true or false, as appropriate. }

EventFilter := handledEvent;
end;

Alert, NoteAlert, CautionAlert, StopAlert, StandardAlert and ModalDialog pass events to your event filter
function before handling each event’, and will handle the event if your event filter
function returns false.

You can also use your event filter function to handle events that ModalDialog does not
handle, such as disk-inserted events?, keyboard equivalents, and mouse-down events.

Alert Boxes and the Event Filter Function

The example event filter, as written, has a limitation in the case of alert boxes with Cancel
buttons. Because the standard event filter function is used, and because the
SetDialogCancelltem function does not apply in the case of alert boxes, the filter function will
not check whether the user has pressed the Escape key or Command-period, highlight
the Cancel push button, or return the item number of that button. It is possible to write
an event filter function which rectifies that deficiency; however, a better approach is to
simply use standardAlert to create alert boxes which require Cancel buttons. The standard
alert structure associated with standardalert allows you to specify which are to be the
default and Cancel buttons in an alert. This is, in effect, the alert box equivalent of the
SetDialogDefaultitem and SetDialogCancelitem calls used in the case of dialog boxes.

7 A major difference between modal alert and dialog boxes and movable modal alert and dialog boxes is that, in the case
of the latter, all events are passed to your event filter function for handling. This allows you to, for example, handle
suspend and resume events when your application is either moved to the background or brought to the front, as well as
other events you might want to handle.

8 Because ModalDialog calls GetNextEvent with a mask which excludes disk-inserted events, your event filter function can call
SetSystemEventMask to reset the mask to accept disk-inserted events if you wish the filter function to handle disk-inserted
events.
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Responding to Events in Modeless Dialog Boxes

As previously stated, you can use the function IsDialogevent to determine whether an event
occurred in a modeless dialog box or a document window and then call DialogSelect to
handle the event if it occurred in a modeless dialog box. Dialogselect handles the event as
follows:

. If the event is an activate or update event, DialogSelect activates or updates the
modeless dialog box and returns false.

. If the event is a key-down or auto-key event, and there is an edit text field in the
modeless dialog box, DialogSelect uses TextEdit to handle text entry and editing and
returns true and the item number. If there is no edit-text field, DialogSelect returns
false.

. If the user presses the mouse button while the cursor is in an edit text field,
DialogSelect responds to the mouse activity as appropriate, that is, by either
displaying the insertion point caret or selecting text. DialogSelect returns false if the
edit text field is disabled, and true and the item number if it is enabled. (Normally,
edit text field items should be disabled.)

. If the user presses the mouse button while the cursor is in an enabled trackable
control, DialogSelect calls TrackControl and, if the user releases the mouse button while
the cursor is still within the control, returns true and the item number.

. If the user presses the mouse button while the cursor is on a disabled item, or if it
is in no item, or if any other event occurs, DialogSelect does nothing.

In the case of a key-down or auto-key event in an edit text field, you will ordinarily need
to filter out Return and Enter key presses and certain Command-key equivalents so that
they are not passed to DialogSelect. In the case of Return and Enter key presses, you
should also highlight the associated push button for eight ticks before calling the
application-defined function which responds to hits on the OK button. In the case of
Command-key presses, you should only allow Command-X, Command-C, and Command-V
to be passed to DialogSelect (SO that DialogSelect can support cut, copy, and paste actions
within the edit text field) and pass any other Command-key equivalents to your
application's menu handling function.

Closing Dialog Boxes

Use closeDialog to dispose of a dialog box if you allocated the memory for the dialog
structure yourself, otherwise use DisposeDialog.

CloseDialog removes a dialog from the screen and deletes it from the window list. It also
releases memory occupied by the data structures associated with the dialog box, such as
control records and text handles. closeDialog does not dispose of the dialog structure or
the 'DITL' resource.

DisposeDialog, on the other hand, calls closebialog and, in addition, releases the memory
occupied by the dialog structure and item list resource.

For modeless dialog boxes, you might find it more efficient to hide the dialog box with
Hidewindow rather than remove its structures. In that way, the dialog will remain available,
and in the same location and with the same settings as when it was last used.

If you adjust the menus when you display a dialog box, be sure to return them to an
appropriate state when you close the dialog box.
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Balloon Help For Alert and Dialog Boxes

Two basic options are available for adding help balloons to alert and dialog boxes:

. Adding a balloon help item to the item list (‘DITL') resource, which will associate
either a rectangle help (‘hrct') resource or a dialog help (‘hdig') resource with that
'DITL' resource. Each hot rectangle component in the 'hrct' resource, and each dialog
item component in the 'hdig' resource, corresponds to an item number in the 'DITL
resource.

. By supplying a window help (‘hwin') resource, which will associate help balloons
defined in either 'hrct' resources or 'hdig' resources with the alert or dialog's window.

The option of using a balloon help item (usually referred to as simply a "help item")
overcomes the major limitation of the 'hwin' resource methodology, which is the inability
to adequately differentiate between alert and dialog boxes with no titles (see Chaper 4 —
Windows, Fig 12). On the other hand, adopting the help item methodology means that
you can only associate help balloons with items in the 'DITL' resource; you cannot provide
a single help balloon for a group of related items (unless, of course, they are grouped
within a primary or secondary group box).

Help items are invisible. In Resorcerer, the presence of a balloon help item in a 'DITL
resource is indicated only by a checkmark in the Balloon Help... item in the Item menu. A
help item's presence in the 'DITL' resource is completely ignored by the Dialog Manager.

When the help item methodolgy is used, the Help Manager automatically tracks the
cursor and displays help balloons when the following conditions are met: the alert or
dialog box has a help item in its 'DITL' resource; your application calls the Dialog Manager
function ModalDialog, IsDialogEvent, Alert, NoteAlert, CautionAlert OI' StopAlert; balloon help is enabled.

Figs 11 and 12 at Chapter 4 — Windows show ‘'hrct' and 'hwin' resources being created
using Resorcerer.

Fig 16 shows a help item being created using Resorcerer.

9

‘hret' and 'hwin' resources are described at Chapter 4 — Windows.
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Fig 17 shows a 'hdig' (dialog help) resource being created using Resorcerer.
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The structure of the hot rectangle compon‘? TEXT STRING T — wﬁZiagﬁeiogelée u
on the item choserMesbage Typge-up
menu in the Resorcerer editing window beld TEXT STRING %\ Other
sets the TYPE OF DATA field. The pop-up n message
items specify the format of the help balloor ALIGNMENT BYTES
The available formats are as follows:
Use these strings Use the string specified within this component of this 'hrct' resource. (Specified i EhiEl9x3dpHEB.

Use 'PICT' resourcesUse the picture stored in the specified 'PICT' resource.

Use 'STR#' resourcebise the specified text string stored in the specified 'STR#' resource.
Used styled text resdaedés styled text stored in the specified 'TEXT' and 'styl' resources.

Use 'STR ' resourcesUse the text string stored in the specified 'STR ' resource.
Skip missing item No help message. Skip this item.

RESORCERER 'hdilg' RESOURCE EDITING WINDOW

FIG 17 - CREATING A 'hdig' RESOURCE USING RESORCERER

=[0= hdlg 130 “For Movable Modal Dialog” from MyApp.p.rsrc =EI=
4 Balloon help version Latest=Z 4
Ilem vifsel Mor Nirsl messaye Slar Linezzages 4l e #1=0 —
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4. For *hwin’'s, match string anywhere in title Off
2. Create window, restore bits, and cause update Off .,
Z. D"l vreale wimdvw | reslere bils, v updale  O07 ~
1. Pretend window port origin is set to (0,0} Off
0. Treat resource IDs as sub-1Ds for owned resources of a D4
Balloon “WDEF® Resource I Standard balloons=0 €
Ballvvn rarialivn vude (Llip pusiliva)  Alony el =ide al lop=0 &
Dialog items 4 €
Murnber of bytes to next record
[¥] Missing message type Skip missing itern=256 3
I
Dialog iterns #1
Hurnber of bytes to next record
+ Messaye Lype Use Lhiese =lring==1 ¢
Tip (¢, 3)=(0,00 ¢
Hot rect (t | b, r)=(0,0001 ¢ ¢
+ Enabled messaye  “Click Lhiz radio Lullon Lo sell Hie brosh Ly pe Lo s
Disabled message €
* Checked message “Indicates that the current brush type is water
Other message 3 |1
falign This field is misnamed in Resorcerer. The HeI';_Manager uses an item's display
rectangle for help balloons. The optional alternate rectangle specified here is L
= transpose the tip if the help balloon does not fit the screen. If the alternate is ¢
greater assurance of the balloon fitting onscreen. If the alternate is larger than
assurance that the balloon will not obscure some imlportant portion within the t
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Main Dialog Manager Constants, Data Types and Functions

In the following:

. The constants, data types, and functions introduced with Mac OS 8 and the
Appearance Manager are shown on a light gray background.

. The functions introduced with Mac OS 8.5 are shown on a dark gray background.

Constants

Dialog Item Types

kControlDialogltem
kButtonDialogltem
kCheckBoxDialogltem
kRadioButtonDialogltem
kResourceControlDialogltem
kStaticTextDialogltem
kEditTextDialogltem
klconDialogltem
kPictureDialogltem= 64
kUserDialogltem
kltemDisableBit

wWrHERoOoONOUL A~ D

6
2

0
128

Item Numbers for OK and Cancel Push Buttons

kStdOkltemIndex
kStdCancelltemIndex

N =

Resource IDs of Alert Box Icons

kStoplcon
kNotelcon
kCautionlcon

o
N = O

Constants Used for theMethod Parameter in AppendDITL

overlayDITL
appendDITLRight
appendDITLBottom

0
1
2

Alert Types

kAlertStopAlert
kAlertNoteAlert
kAlertCautionAlert
kAlertPlainAlert

WN RO

Alert Button Constants

kAlertStdAlertOKButton
kAlertStdAlertCancelButton
kAlertStdAlertOtherButton
kAlertStdAlertHelpButton

PWNH

Alert Default Text Constants

kAlertDefaultOKText
kAlertDefaultCancelText
kAlertDefaultOtherText

o
1
(S =

Dialog Feature Flag Constants

kDialogFlagsUseThemeBackground
kDialogFlagsUseControlHierarchy
kDialogFlagsHandleMovableModal
kDialogFlagsUseThemeControls

oA~ NHE

Alert Feature Flag Constants
kAlertFlagsUseThemeBackground =1
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kAlertFlagsUseControlHierarchy
kAlertFlagsAlertlsMovable
kAlertFlagsUseThemeControls

o
o A~ N

Dialog Font Flag Constants

kDialogFontNoFontStyle =0

kDialogFontUseFontMask = $0001
kDialogFontUseFaceMask = $0002
kDialogFontUseSizeMask = $0004
kDialogFontUseForeColorMask = $0008
kDialogFontUseBackColorMask = $0010
kDialogFontUseModeMask = $0020
kDialogFontUseJustMask = $0040
kDialogFontUseAllMask = $00FF
kDialogFontAddFontSizeMask = $0100
kDialogFontUseFontNameMask = $0200

Constants Used for proclD Parameter in NewDialog and NewColorDialog and inProcID Parameter

in NewFeaturesDialog

kWindowDocumentProc = 1024
kWindowPlainDialogProc = 1040
kWindowShadowDialogProc = 1041
kWindowModalDialogProc = 1042
kWindowMovableModalDialogProc = 1043
kWindowAlertProc = 1044
kWindowMovableAlertProc = 1045

Data Types

{ Modeless dialog box }

{ Modal dialog box }

{ Modal dialog box }

{ Modal dialog box }

{ Movable modal dialog box }
{ Modal alert box }

{ Movable modal alert box }

typedef WindowPtr DialogPtr;

Dialog Structure

DialogRecordPtr = ~DialogRecord;
DialogRecord = RECORD

window:

items: Handle;

textH: TEHandle;

editField: SIntl6;

editOpen: SIntl6;

aDefltem: Sint16;
END;

DialogPeek = ~DialogRecord;

Standard Alert Structure

TYPE

WindowRecord; { Dialog's window structure. }
{ Item list resource. }
{ Current editable text item. }
{ Editable text item number minus 1. }
{ (Used internally.) }
{ Default push button item number. }

AlertStdAlertParamRecPtr = ~AlertStdAlertParamRec;

AlertStdAlertParamRec = RECORD

movable: BOOLEAN;
helpButton: BOOLEAN;
filterProc: ModalFilterUPP;
defaultText: StringPtr;
cancelText: StringPtr;
otherText: StringPtr;
defaultButton: Sintl6;
cancelButton: SIntl6;
position: Ulntl6;
END;
Functions

{ Whether or not the alert is movable. }
{ Whether or not the alert includes a Help button.}
{ User-providid filter function. }
{ Text for button in OK position.}
{ Text for button in cancel position.}
{ Text for button in left position.}
{ Which button behaves as the default.}
{ Which one behaves as cancel (can be 0).}
{ Position (kWindowDefaultPosition in this case }
{ equals kWindowAlertPositionParentWindowScreen }

Initialising the Dialog Manager

PROCEDURE InitDialogs(ignored: UNIV Ptr);
PROCEDURE ErrorSound(soundProc: SoundUPP);
PROCEDURE SetDialogFont(value: SInt16);
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Creating Alerts

FUNCTION Alert(alertIlD: SInt16; modalFilter: ModalFilterUPP): DialogltemIndex;

FUNCTION StopAlert(alertID: SInt16; modalFilter: ModalFilterUPP): DialogltemIndex;

FUNCTION NoteAlert(alertID: SInt16; modalFilter: ModalFilterUPP): DialogltemIndex;

FUNCTION CautionAlert(alertID: SInt16; modalFilter: ModalFilterUPP): DialogltemIndex;

FUNCTION StandardAlert(inAlertType: AlertType; inError: StringPtr; inExplanation: StringPtr;
inAlertParam: AlertStdAlertParamPtr; VAR outltemHit: SInt16): OSErr;

FUNCTION GetAlertStage: SInt16;

PROCEDURE ResetAlertStage;

Creating and Disposing of Dialog Boxes

FUNCTION GetNewDialog(dialogID: SInt16; dStorage: UNIV Ptr; behind: WindowPtr): DialogPtr;

FUNCTION NewDialog(dStorage: UNIV Ptr; {CONST}VAR boundsRect: Rect; title: ConstStr255Param;
visible: BOOLEAN; procID: SInt16; behind: WindowPtr; goAwayFlag: BOOLEAN;
refCon: SInt32; items: Handle): DialogPtr;

FUNCTION NewColorDialog(dStorage: UNIV Ptr; { CONST}VAR boundsRect: Rect;
title: ConstStr255Param; visible: BOOLEAN; proclD: Sintl16; behind: WindowPtr;
goAwayFlag: BOOLEAN; refCon: SInt32; items: Handle): DialogPtr;

FUNCTION NewFeaturesDialog(inStorage: UNIV Ptr; {CONST}VAR inBoundsRect: Rect;
inTitle: ConstStr255Param; inlsVisible: BOOLEAN; inProcID: SInt16;
inBehind: WindowPtr; inGoAwayFlag: BOOLEAN; inRefCon: SInt32;
inltemListHandle: Handle; inFlags: UInt32): DialogPtr;

PROCEDURE CloseDialog(theDialog: DialogPtr);

PROCEDURE DisposeDialog(theDialog: DialogPtr);

Manipulating Items in Alert and Dialog Boxes

PROCEDURE GetDialogltem(theDialog: DialogPtr; itemNo: Dialogltemindex;
VAR itemType: DialogltemType; VAR item: Handle; VAR box: Rect);
PROCEDURE SetDialogltem(theDialog: DialogPtr; itemNo: DialogltemIndex;
itemType: DialogltemType; item: Handle; {CONST}VAR box: Rect);
FUNCTION GetDialogltemAsControl(inDialog: DialogPtr; inltemNo: SInt16;
VAR outControl: ControlHandle): OSErr;
FUNCTION MoveDialogltem(inDialog: DialogPtr; inltemNo: SIntl6; inHoriz: SInt16;
inVert: SInt16): OSErr;
FUNCTION SizeDialogltem(inDialog: DialogPtr; inltemNo: SInt16; inHeight: SInt16;
inWidth: SIntl16): OSErr;
FUNCTION AutoSizeDialog(inDialog: DialogPtr): OSErr;
PROCEDURE HideDialogltem(theDialog: DialogPtr; itemNo: Dialogltemindex);
PROCEDURE ShowDialogltem(theDialog: DialogPtr; itemNo: Dialogltemindex);
FUNCTION FindDialogltem(theDialog: DialogPtr; thePt: Point): DialogltemIindexZeroBased;
PROCEDURE AppendDITL(theDialog: DialogPtr; theHandle: Handle; method: DITLMethod);
FUNCTION CountDITL(theDialog: DialogPtr): Dialogltemindex;
PROCEDURE ShortenDITL(theDialog: DialogPtr; numberltems: DialogltemIndex);

Handling Text in Alert and Dialog Boxes

void ParamText(ConstStr255Param param0,ConstStr255Param param1,ConstStr255Param param?2,
ConstStr255Param param3);

PROCEDURE SetDialogltemText(item: Handle; text: ConstStr255Param);

PROCEDURE GetDialogltemText(item: Handle; VAR text: Str255);

PROCEDURE SelectDialogltemText(theDialog: DialogPtr; itemNo: Dialogltemindex; strtSel: SInt16;
endSel: SIntl16);

PROCEDURE DialogCut(theDialog: DialogPtr);

PROCEDURE DialogPaste(theDialog: DialogPtr);

PROCEDURE DialogCopy(theDialog: DialogPtr);

PROCEDURE DialogDelete(theDialog: DialogPtr);

Handling Events in Dialog Boxes

PROCEDURE ModalDialog(modalFilter: ModalFilterUPP; VAR itemHit: DialogltemIndex);
FUNCTION IsDialogEvent({CONST}VAR theEvent: EventRecord): BOOLEAN;
FUNCTION DialogSelect({CONST}VAR theEvent: EventRecord; VAR theDialog: DialogPtr;
VAR itemHit: DialogltemIndex): BOOLEAN;
PROCEDURE DrawDialog(theDialog: DialogPtr);
PROCEDURE UpdateDialog(theDialog: DialogPtr; updateRgn: RgnHandle);
FUNCTION SetModalDialogEventMask(inDialog: DialogPtr; inMask: EventMask): OSStatus;
FUNCTION GetModalDialogEventMask(inDialog: DialogPtr; VAR outMask: EventMask): OSStatus;
FUNCTION SetDialogTimeout(inDialog: DialogPtr; inButtonToPress: SInt16;
inSecondsToWait: UInt32): OSStatus;
FUNCTION GetDialogTimeout(inDialog: DialogPtr; VAR outButtonToPress: SInt16;
VAR outSecondsToWait: UInt32; VAR outSecondsRemaining: UInt32): OSStatus;

Creating a Routine Descriptor For an Event Filter Function
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FUNCTION NewModalFilterProc(userRoutine: ModalFilterProcPtr): ModalFilterUPP;

Demonstration Program

£ Q0000MMMMMUUUHHN000000000000
// DialogsAndAlerts.p

z GOO0000AA000MAOOGHHOOHHOHIOCGHHOGHKIOGHHO NN NN

/I If Mac OS 8.5 is present, this program initially opens a small modal dialog box which
/l is automatically closed after 10 seconds, the timeout value having been set by a call
// to SetDialogTimeout. The program then:

/I

/l = Opens a window with an Appearance-compliant window header for the purposes of
/! displaying advisory text and for proving correct window updating and activation/

1 deactivation in the presence of alert and dialog boxes.

// = Allows the user to invoke a demonstration modal alert box, movable modal alert box,
/! modal dialog box, movable modal dialog box, and modeless dialog box via the
/! Demonstration menu.

// The modal alert box is created using 'ALRT' and 'alrx' resources.

1

// The movable modal alert box is created programmatically using the StandardAlert

// function and a standard alert structure.

/!

// The modal dialog box contains three checkboxes in one group box, and two pop-up menu
// buttons in another group box.

/!

// The movable modal dialog box contains four radio buttons in one group box, and a clock
// control and edit text field in another group box..

/

// The modeless dialog box contains, amongst other items, an edit text field.

/!

// The modal alert box, movable modal alert box, modal dialog box, and movable modal
// dialog box use an application-defined event filter function.

1

// The program utilises the following resources:

/

/l * An 'MBAR' resource, and 'MENU' resources for Apple, File, Demonstration, and Help
/! pull-down menus, and the pop-up menu buttons (preload, non-purgeable).

1

// » A 'WIND' resource (purgeable) (initially visible).

/

// * An 'ALRT' resource (purgeable), together with an associated 'alrx' resource

/! (purgeable), and 'dftb' resource (non-purgeable, but 'dftb' resources are auto-

i matically marked purgeable when read in).

// » 'DLOG' resources (purgeable) (initially not visible) and associated 'DITL'
/! resources (purgeable), 'dlgx' resources (purgeable), and 'dftb' resources (non-
// purgeable, but 'dftb' resources are automatically marked purgeable when read in).

/l * 'CNTL' resources for primary group boxes, separator lines, pop-up menu buttons,
/! a clock, and an image well (all purgeable).

/l = A'STR#' resources (purgeable) containing the label and narrative text for the
1 movable modal alert box.

/l * A'cicn' resource (purgeable) for the modeless dialog box.

/l + A 'ppat' resource (purgeable), which is used to colour the content region of the
1 document window for update proving purposes.

/l = 'hdlg' resources (purgeable) containing balloon help information for the modal and
1l and movable modal dialog boxes.

// * An 'hrct' resource and associated 'hwin' resource (both purgeable) containing
/! balloon help information for the modeless dialog box.

// * A 'SIZE' resource with the acceptSuspendResumeEvents and doesActivateOnFGSwitch,
//  and is32BitCompatible flags set.

11 O000A0000OOOMAOGHHOOGHOHHONHOGHHOOOGHHNNOC NN }

program DialogsAndAlerts;

Dialogs and Alerts



uses

{ Universal Interfaces. }
Appearance, Devices, Fonts, GestaltEqu, Menus, Processes, Sound, TextUtils, ToolUtils,
LowMem;

const

rMenubar = 128;
mApple = 128;
iAbout = 1;

mFile = 129;

iClose = 4;

iQuit = 11;

mEdit = 130;

iCut = 3;

iCopy = 4;

iPaste = 5;

iClear = 6;
mDemonstration = 131;
iModalAlert = 1;
iMovableAlert = 2;
iModalDialog = 3;
iMovableModalDialog = 4;
iModeless = 5;
rWindow = 128;
rAlert = 128;
rModal = 129;
iGridSnap = 4;
iShowGrid = 5;
iShowRulers = 6;
iFont = 11;

iSound = 12;
rMovable = 130;
iCharcoal = 7,
iOilPaint = 8;
iPencil = 9;

iChalk = 10;
iClockOne = 12;
rModeless = 131;
iEditText = 2;
rSplash = 132;
rAlertStrings = 128;
sLabel = 1;
sNarrative = 2;
rPixelPattern = 128;
kSearchModeless = 1;

kReturn = char($0D);
kEnter = char($03);

kEscape = char($1B);
kPeriod = char($2E);

MAXLONG = $7FFFFFFF;

var

gPreAllocatedBlockPtr : Ptr;
gEventFilterUPP : ModalFilterUPP;
gCurrentString : Str255;
gWindowPtr : WindowPtr;
gPixelDepth : SIntl6;
glsColourDevice : boolean;
gSleepTime : SInt32;
gDone : boolean;
glnBackground : boolean;
gGridSnap : SIntl6;
gShowGrid : SInt16;
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gShowRule : SIntl6;
gBrushType : SIntl6;
gSearchModelessDialogPtr : DialogPtr;

e e e e e e e e main
program block variables

osError : OSErr;

response : SInt32;

ignored : OSStatus;

itemHit : SInt16;
modalDialogPtr : DialogPtr;
mainMenubarHdl : Handle;
mainMenuHdl| : MenuHandle;

procedure DolnitManagers; forward;

procedure EventLoop; forward;

procedure Doldle; forward;

procedure DoEvents({const} var theEvent : EventRecord); forward;

procedure DoMouseDown({const} var theEvent : EventRecord); forward;

procedure DoKeyDown({const} var theEvent : EventRecord); forward;

procedure DoUpdate({const} var theEvent : EventRecord); forward;

procedure DoUpdateDocument(theWindowPtr : WindowPtr); forward;

procedure DoUpdateModelessDialog({const} var theEvent : EventRecord); forward;

procedure DoActivate({const} var theEvent : EventRecord); forward;

procedure DoOSEvent({const} var theEvent : EventRecord); forward;

procedure DoActivateDocument(theWindowPtr : WindowPtr; becomingActive : boolean); forward;

procedure DoActivateModelessDialog({const} var theEvent : EventRecord;
becomingActive : boolean); forward;

procedure DoAdjustMenus; forward;

procedure DoMenuChoice(menuChoice : SInt32); forward;

procedure DoEditMenu(menultem : SInt16); forward;

procedure DoDemonstrationMenu(menultem : SInt16); forward;

procedure DoExplicitlyDeactivateDocument; forward;

function DoMovableModalAlert : boolean; forward;

function DoModalDialog : boolean; forward;

function DoMovableModalDialog : boolean; forward;

function DoCreateOrShowModelessDialog : boolean; forward;

procedure DolnContent({const} var theEvent : EventRecord); forward;

procedure DoButtonHitInSearchModeless; forward;

procedure DoHideModelessDialog(theWindowPtr : WindowPtr); forward;

procedure DoPopupMenuChoice(controlHdI : ControlHandle; intl, int2 : SInt16); forward;

procedure DoDrawMessage(theWindowPtr : WindowPtr; inState : boolean); forward;

procedure DoPlaySound(soundName : Str255); forward;

procedure DoGetDepthAndDevice; forward;

function EventFilter(theDialogPtr : DialogPtr; {const} var theEvent : EventRecord;
var theltem : SInt16) : boolean; forward;

11 0000A000XAOOMNONHOOGHHOOGHMACNONNO NN DolnitManagers

procedure DolnitManagers;
var
osError : OSErr;

begin
MaxApplZone;
MoreMasters;

InitGraf(@qd.thePort);
InitFonts;
InitWindows;
InitMenus;

TEInit;

InitDialogs(nil);

InitCursor;
FlushEvents(everyEvent, 0);

osError := RegisterAppearanceClient;

end;
{ of procedure DolnitManagers }

11 O000A0000A0CMOMOO MMM NN NN NN EventLoop
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procedure EventLoop;
var
theEvent : EventRecord;
gotEvent : Boolean;

begin
gSleepTime := MAXLONG;
gDone := false;

while not gDone do
begin
gotEvent := WaitNextEvent(everyEvent, theEvent, gSleepTime, nil);

if gotEvent then
begin
DoEvents(theEvent);
end

else begin
Doldle;
end;

end;

end;
{ of procedure EventLoop }

11 O000A000HAO0HAOGHOGHAOHHO MO HHOOONNNO0 N0 Doldle

procedure Doldle;

begin

if (FrontWindow = gSearchModelessDialogPtr) then
begin
IdleControls(gSearchModelessDialogPtr);
end;

end;
{ of procedure Doldle }

11 000000000 GHHOOOGHHCUHNNO NN KNI IHNOO0 NN DoEvents

procedure DoEvents({const} var theEvent : EventRecord);
begin
case (theEvent.what) of

mouseDown: begin
DoMouseDown(theEvent);
end;

keyDown, autoKey: begin
DoKeyDown(theEvent);
end;

updateEvt: begin
DoUpdate(theEvent);
end;

activateEvt: begin
DoActivate(theEvent);
end;

osEvt: begin
DoOSEvent(theEvent);
HiliteMenu(0);
end;

otherwise begin
end;
end;
{ of case statement }
end;
{ of procedure DoEvents }

11 OO000MOOO0MKIOO0NKIIOOONKKIOONMHIOOONKIONHNIOONKKIONNUNNOOONKK) DoMouseDown
procedure DoMouseDown({const} var theEvent : EventRecord);

;Il'?erWindothr : WindowPtr;

partCode : SIntl6;

begin
partCode := FindWindow(theEvent.where, theWindowPtr);

case partCode of
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inMenuBar: begin
DoAdjustMenus;
DoMenuChoice(MenuSelect(theEvent.where));
end;

inContent: begin

if (theWindowPtr <> FrontWindow) then
begin
SelectWindow(theWindowPtr);
end

else begin
DolnContent(theEvent);
end;

end;

inDrag: begin
DragWindow(theWindowPtr, theEvent.where, gd.screenBits.bounds);
end;

inGoAway: begin
if (TrackGoAway(theWindowPtr, theEvent.where)) then
begin
if (WindowPeek(theWindowPtr)”.windowKind = kDialogWindowKind) then
begin
DoHideModelessDialog(theWindowPtr);
gCurrentString := 'Balloon help is available for dialog boxes';
end;
end;
end;

otherwise begin
end;
end;
{ of case statement }
end;
{ of procedure DoMouseDown }

11 00000000 HOGHHOOGMCIHNOINMOGHHOOHHOUNNOONNNOO DoKeyDown

procedure DoKeyDown({const} var theEvent : EventRecord);
var
theWindowPtr : WindowPtr;
charCode : char;
whichModeless, itemHit : SIntl6;
controlHdI : ControlHandle;
finalTicks : UInt32;
ignoredBool : boolean;
ignoredErr : OSErr;

begin
theWindowPtr := FrontWindow;
charCode := char(BAnd(theEvent.message, charCodeMask));

if not IsDialogEvent(theEvent) then
begin
if (BAnd(theEvent.modifiers, cmdKey) <> 0) then
begin
DoAdjustMenus;
DoMenuChoice(MenuEvent(theEvent));
end;
end
else begin
whichModeless := WindowPeek(theWindowPtr)~.refCon;
if (whichModeless = kSearchModeless) then
begin
if ((charCode = kReturn) or (charCode = kEnter)) then
begin
ignoredErr := GetDialogltemAsControl(theWindowPtr, kStdOkltemIndex, controlHdI);
HiliteControl(controlHdI, kControlButtonPart);
Delay(8, finalTicks);
HiliteControl(controlHdI, kControlNoPart);
DoButtonHitinSearchModeless;
Exit(DoKeyDown);
end;

if (BAnd(theEvent.modifiers, cmdKey) <> 0) then
begin
if ((charCode = 'X') or (charCode = 'x') or (charCode = 'C') or (charCode = 'c') or
(charCode = 'V') or (charCode = 'v')) then
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begin
HiliteMenu(mEdit);
ignoredBool := DialogSelect(theEvent, DialogPtr(theWindowPtr), itemHit);
Delay(4, finalTicks);
HiliteMenu(0);
end
else begin
DoAdjustMenus;
DoMenuChoice(MenuEvent(theEvent));
end;

return;
end;

ignoredBool := DialogSelect(theEvent, DialogPtr(theWindowPtr), itemHit);
end;
end;
end;
{ of procedure DoKeyDown }

11 O0GOOGHIOOOHHNIOOOHHIOOOGHIOOOUHICUNNOO KNI KNI UHHOO00NNN¢ DoUpdate

procedure DoUpdate({const} var theEvent : EventRecord);
var
theWindowPtr : WindowPtr;

begin
theWindowPtr := WindowPtr(theEvent.message);

if not IsDialogEvent(theEvent) then
begin
DoUpdateDocument(theWindowPtr);
end

else begin
DoUpdateModelessDialog(theEvent);
end;

end;
{ of procedure DoUpdate }

11 O00KOOGHIOOUHHNOOO MO GHHOOOIHHOCUNNO NN KN0 DoUpdateDocument

procedure DoUpdateDocument(theWindowPtr : WindowPtr);
var
oldPort : GrafPtr;
pixpatHdl| : PixPatHandle;

begin
BeginUpdate(theWindowPtr);

GetPort(oldPort);
SetPort(theWindowPtr);

pixpatHdI := GetPixPat(rPixelPattern);

FillCRect(theWindowPtr”.portRect, pixpatHdl);

DisposePixPat(pixpatHdl);

DoDrawMessage(theWindowPtr, (theWindowPtr = FrontWindow) and not ginBackground);

SetPort(oldPort);

EndUpdate(theWindowPtr);
end;
{ of procedure DoUpdateDocument }

11000000 HIOOGHIOIHOIHNO MO0 DoUpdateModelessDialog

procedure DoUpdateModelessDialog({const} var theEvent : EventRecord);
var
theWindowPtr : WindowPtr;
itemHit : SInt16;
ignoredBool : boolean;

begin
ignoredBool := DialogSelect(theEvent, theWindowPtr, itemHit);
end;

{ of procedure DoUpdateModelessDialog }

11 0000A0000A000MOHOO MMM N NN NN DoActivate

procedure DoActivate({const} var theEvent : EventRecord);
var
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theWindowPtr : WindowPtr;
becomingActive : Boolean;

begin
theWindowPtr := WindowPtr(theEvent.message);
becomingActive := BAnd(theEvent.modifiers, activeFlag) = activeFlag;

if not IsDialogEvent(theEvent) then
begin
DoActivateDocument(theWindowPtr, becomingActive);
end

else begin
DoActivateModelessDialog(theEvent, becomingActive);
end;

end;
{ of procedure DoActivate }

11 Q0000000000 NI NNNHAO NI 0NNNNNO DoOSEvent

procedure DoOSEvent({const} var theEvent : EventRecord);
var
theWindowPtr : WindowPtr;

begin
case BAnd(BSR(theEvent.message, 24), $000000FF) of

suspendResumeMessage: begin
theWindowPtr := FrontWindow;
glnBackground := BAnd(theEvent.message, resumeFlag) = 0;

if not IsDialogEvent(theEvent) then
begin
DoActivateDocument(theWindowPtr, not ginBackground);
end

else begin
DoActivateModelessDialog(theEvent, not glnBackground);
end;

end;

mouseMovedMessage: begin
end;

otherwise begin
end;
end;
{ of case statement }
end;
{ of procedure DoOSEvent }

11 O000A0000O0OM0GMOGHOOMOCNOC NN DoActivateDocument

procedure DoActivateDocument(theWindowPtr : WindowPtr; becomingActive : boolean);
begin
if becomingActive then
begin
DoAdjustMenus;
end;

DoDrawMessage(theWindowPtr, becomingActive);
end;
{ of procedure DoActivateDocument }

11 0000000000000 DoActivateModelessDialog

procedure DoActivateModelessDialog({const} var theEvent : EventRecord;
becomingActive : boolean);
var
whichModeless : SIntl6;
theWindowPtr : WindowPtr;
itemHit : SInt16;
ignoredBool : boolean;

begin
ignoredBool := DialogSelect(theEvent, theWindowPtr, itemHit);

if becomingActive then
begin
DoAdjustMenus;
whichModeless := WindowPeek(theWindowPtr)”.refCon;
if (whichModeless = kSearchModeless) then
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begin
gSleepTime := LMGetCaretTime;
end;
end
else begin
whichModeless := WindowPeek(theWindowPtr)~.refCon;
if (whichModeless = kSearchModeless) then
begin
gSleepTime := MAXLONG;
end;
end;
end;
{ of procedure DoActivateModelessDialog }

11 O00A000HMOOOHOOGHMOGMCIHMO MO GHHOOONONNNOO0K) DoAdjustMenus

procedure DoAdjustMenus;
var
theWindowPtr : WindowPtr;
menuHd| : MenuHandle;

begin
theWindowPtr := FrontWindow;

if (WindowPeek(theWindowPtr)”~.windowKind = kApplicationWindowKind) then
begin
menuHd| := GetMenuHandle(mFile);
Enableltem(menuHdl, 0);
Disableltem(menuHdl, 4);
menuHd| := GetMenuHandle(mEdit);
Disableltem(menuHdl, 0);
menuHd| := GetMenuHandle(mDemonstration);
Enableltem(menuHdl, 0);
Enableltem(menuHdl, 5);
end

else if (WindowPeek(theWindowPtr)”~.windowKind = kDialogWindowKind) then
begin
menuHd| := GetMenuHandle(mFile);
Enableltem(menuHdl, 0);
Enableltem(menuHdl, 4);
menuHd| := GetMenuHandle(mEdit);
Enableltem(menuHdl, 0);
menuHd| := GetMenuHandle(mDemonstration);
Enableltem(menuHdl, 0);
Disableltem(menuHdl, 5);
end;

DrawMenuBar;
end;
{ of procedure DoAdjustMenus }

11 0000000000 HHOOONHNNOO0NK DoMenuChoice

procedure DoMenuChoice(menuChoice : SInt32);
var
menulD, menultem : SInt16;
itemName : Str255;
daDriverRefNum : SInt16;

begin
menulD := HiWord(menuChoice);
menultem := LoWord(menuChoice);

if (menulD = 0) then
return;

case menulD of

mApple: begin

if (menultem = iAbout) then
begin
SysBeep(10);
end

else begin
GetMenultemText(GetMenuHandle(mApple), menultem, itemName);
daDriverRefNum := OpenDeskAcc(itemName);
end;

end;

mFile: begin
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if (menultem = iQuit) then
begin
gDone := true;
end

else if (menultem = iClose) then
begin

if (WindowPeek(FrontWindow)”.windowKind = kDialogWindowKind) then

begin
DoHideModelessDialog(FrontWindow);
end;
end;
end;

mEdit: begin
DoEditMenu(menultem);
end;

mDemonstration: begin
DoDemonstrationMenu(menultem);
end;

otherwise begin
end;
end;
{ of case statement }

HiliteMenu(0);
end;
{ of procedure DoMenuChoice }

1100000000000 GHMOOINHNNOCNNNO DoEditMenu

procedure DoEditMenu(menultem : SInt16);
var
theWindowPtr : WindowPtr;
whichModeless : SInt16;

begin
theWindowPtr := FrontWindow;

if (WindowPeek(theWindowPtr)”~.windowKind = kDialogWindowKind) then

begin

whichModeless := WindowPeek(theWindowPtr)”~.refCon;

if (whichModeless = kSearchModeless) then
begin
case menultem of

iCut: begin
DialogCut(DialogPtr(theWindowPtr));
end;

iCopy: begin
DialogCopy(DialogPtr(theWindowPtr));
end;

iPaste: begin
DialogPaste(DialogPtr(theWindowPtr));
end;

iClear: begin
DialogDelete(DialogPtr(theWindowPtr));
end;

otherwise begin
end;
end;
{ of case statement }
end;
end;
end;
{ of procedure DoEditMenu }

11 0000000000000 CHOOOMHNNO NN DoDemonstrationMenu

procedure DoDemonstrationMenu(menultem : SInt16);

var
ignoredErr : OSErr;

begin
case menultem of
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iModalAlert: begin
DoExplicitlyDeactivateDocument;
ignoredErr := StopAlert(rAlert, gEventFilterUPP);
end;

iMovableAlert: begin
DoExplicitlyDeactivateDocument;
if not DoMovableModalAlert then
begin
SysBeep(10);
ExitToShell;
end;
end;

iModalDialog: begin

DoExplicitlyDeactivateDocument;
if not DoModalDialog then

begin

SysBeep(10);

ExitToShell;

end;
end;

iMovableModalDialog: begin
DoExplicitlyDeactivateDocument;
if not DoMovableModalDialog then
begin
SysBeep(10);
ExitToShell;
end;
end;

iModeless: begin
if not DoCreateOrShowModelessDialog then
begin
SysBeep(10);
ExitToShell;
end;
end;

otherwise begin
end;
end;
{ of case statement }
end;
{ of procedure DoDemonstrationMenu }

11 000000000000 HHOO0H00NNOONN0 DoExplicitlyDeactivateDocument

procedure DoExplicitlyDeactivateDocument;

begin

if ((FrontWindow <> nil) and (WindowPeek(FrontWindow)”~.windowKind <> kDialogWindowKind)) then
begin
DoActivateDocument(FrontWindow, false);
end;

end;
{ of procedure DoExplicitlyDeactivateDocument }

11 0000000 GHHOOHCUNNO NN NN DoMovableModalAlert

function DoMovableModalAlert : boolean;
var
paramRec : AlertStdAlertParamRec;
labelText : Str255;
narrativeText : Str255;
osError : OSErr;
itemHit : SInt16;

begin

paramRec.movable := true;

paramRec.helpButton := false;

paramRec.filterProc := gEventFilterUPP;
paramRec.defaultText := StringPtr(kAlertDefaultOKText);
paramRec.cancelText := StringPtr(kAlertDefaultCancelText);
paramRec.otherText := nil;

paramRec.defaultButton := kAlertStdAlertOKButton;
paramRec.cancelButton := kAlertStdAlertCancelButton;
paramRec.position := kWindowDefaultPosition;
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GetlndString(labelText, rAlertStrings, sLabel);
GetIndString(narrativeText, rAlertStrings, sNarrative);

osError := StandardAlert(kAlertCautionAlert, @labelText, @narrativeText, @paramRec, itemHit);
if (osError = noErr) then
begin
DoMovableModalAlert := true;
end
else begin
DoMovableModalAlert := false;
end;
end;
{ of function DoMovableModalAlert }

11 O00000OOOHOGHIOGMCINNMOGHNOIHNONNNOO0K) DoModalDialog

function DoModalDialog : boolean;
var
modalDialogPtr : DialogPtr;
controlHdI : ControlHandle;
itemHit, controlValue : SIntl6;
ignoredErr : OSErr;

begin
modalDialogPtr := GetNewDialog(rModal, nil, WindowPtr(-1));
if (modalDialogPtr = nil) then

begin

DoModalDialog := false;

Exit(DoModalDialog);

end;

ignoredErr := SetDialogDefaultitem(modalDialogPtr, kStdOkltemIndex);
ignoredErr := SetDialogCancelltem(modalDialogPtr, kStdCancelltemIndex);

ignoredErr := GetDialogltemAsControl(modalDialogPtr, iGridSnap, controlHdl);
SetControlValue(controlHdI, gGridSnap);

ignoredErr := GetDialogltemAsControl(modalDialogPtr, iShowGrid, controlHdl);
SetControlValue(controlHdIl, gShowGrid);

ignoredErr := GetDialogltemAsControl(modalDialogPtr, iShowRulers, controlHdl);
SetControlValue(controlHdl, gShowRule);

ShowWindow(modalDialogPtr);

repeat
begin
ModalDialog(gEventFilterUPP, itemHit);

if ((itemHit = iGridSnap) or (itemHit = iShowGrid) or (itemHit = iShowRulers)) then
begin
ignoredErr := GetDialogltemAsControl(modalDialogPtr, itemHit, controlHdl);
SetControlValue(controlHdl, (GetControlValue(controlHdIl) + 1) mod 2);
end

else if ((itemHit = iFont) or (itemHit = iSound)) then
begin
ignoredErr := GetDialogltemAsControl(modalDialogPtr, itemHit, controlHdl);
controlValue := GetControlValue(controlHdl);
DoPopupMenuChoice(controlHdl, controlValue, itemHit);
end;

end;

until ((itemHit = kStdOkltemIndex) or (itemHit = kStdCancelltemIndex));

if (itemHit = kStdOkltemIndex) then
begin
ignoredErr := GetDialogltemAsControl(modalDialogPtr, iGridSnap, controlHdl);
gGridSnap := GetControlValue(controlHdl);
ignoredErr := GetDialogltemAsControl(modalDialogPtr, iShowGrid, controlHdl);
gShowGrid := GetControlValue(controlHdl);
ignoredErr := GetDialogltemAsControl(modalDialogPtr, iShowRulers, controlHdl);
gShowRule := GetControlValue(controlHdl);
end;

DisposeDialog(modalDialogPtr);
gCurrentString := 'Balloon help is available for dialog boxes';
DoModalDialog := true;

end;
{ of function DoModalDialog }

11 0000000000000 DoMovableModalDialog
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function DoMovableModalDialog : boolean;
var
movableModaDialogPtr : DialogPtr;
controlHdI| : ControlHandle;
oldBrushType, itemHit, a : SInt16;
ignoredErr : OSErr;

begin
movableModaDialogPtr := GetNewDialog(rMovable, nil, WindowPtr(-1));
if (movableModaDialogPtr = nil) then

begin

DoMovableModalDialog := false;

Exit(DoMovableModalDialog);

end;

ignoredErr := SetDialogDefaultltem(movableModaDialogPtr, kStdOkltemIndex);
ignoredErr := SetDialogCancelltem(movableModaDialogPtr, kStdCancelltemIndex);
ignoredErr := SetDialogTracksCursor(movableModaDialogPtr, true);

ignoredErr := GetDialogltemAsControl(movableModaDialogPtr, gBrushType, controlHdl);
SetControlValue(controlHdI, kControlRadioButtonCheckedValue);

ignoredErr := GetDialogltemAsControl(movableModaDialogPtr, iClockOne, controlHdl);
ignoredErr := SetKeyboardFocus(movableModaDialogPtr, controlHdI, kControlClockPart);

oldBrushType := gBrushType;
ShowWindow(movableModaDialogPtr);

repeat
begin
ModalDialog(gEventFilterUPP, itemHit);

if ((itemHit >= iCharcoal) and (itemHit <= iChalk)) then
begin
for a := iCharcoal to iChalk do
begin
ignoredErr := GetDialogltemAsControl(movableModaDialogPtr, a, controlHdl);
SetControlValue(controlHdI, kControlRadioButtonUncheckedValue);
end;

ignoredErr := GetDialogltemAsControl(movableModaDialogPtr, itemHit, controlHdl);
SetControlValue(controlHdIl, kControlRadioButtonCheckedValue);
gBrushType := itemHit;
end;
end;
until ((itemHit = kStdOkltemIndex) or (itemHit = kStdCancelltemIndex));

if (itemHit = kStdCancelltemIndex) then
begin
gBrushType := oldBrushType;
end;

DisposeDialog(movableModaDialogPtr);

DoMovableModalDialog := true;
end;
{ of function DoMovableModalDialog }

11 O000A0000A0O0MOONOOOGHHOOO0NC0NN0NNNO0) DoCreateOrShowModelessDialog

function DoCreateOrShowModelessDialog : boolean;
var
booleanData : Boolean;
controlHdI : ControlHandle;
stringData : Str255;
ignoredErr : OSErr;

begin
stringData := 'wicked googly";
if (gSearchModelessDialogPtr = nil) then
begin
gSearchModelessDialogPtr := GetNewDialog(rModeless, gPreAllocatedBlockPtr,
WindowPtr(-1));
if (gSearchModelessDialogPtr = nil) then
begin
DoCreateOrShowModelessDialog := false;
Exit(DoCreateOrShowModelessDialog);
end;
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SetWRefCon(gSearchModelessDialogPtr, Sint32(kSearchModeless));

booleanData := true;

ignoredErr := GetDialogltemAsControl(gSearchModelessDialogPtr, kStdOkltemIndex, controlHdI);

ignoredErr := SetControlData(controlHdl, kControINoPart, kControlPushButtonDefaultTag,
sizeof(booleanData), @booleanData);

ignoredErr := GetDialogltemAsControl(gSearchModelessDialogPtr, iEditText, controlHdl);
SetDialogltemText(Handle(controlHdl), stringData);
SelectDialogltemText(gSearchModelessDialogPtr, iEditText, 0, 32767);

ShowWindow(gSearchModelessDialogPtr);
end

else begin
ShowWindow(gSearchModelessDialogPtr);
SelectWindow(gSearchModelessDialogPtr);
end;

DoCreateOrShowModelessDialog := true;
end;
{ of function DoCreateOrShowModelessDialog }

11 0000A0000000MOCMMOGHHOOGHAOCNOO NN DolnContent

procedure DolnContent({const} var theEvent : EventRecord);
var
theWindowPtr : WindowPtr;
whichModeless : SInt16;
dialogPtr : DialogPtr;
itemHit : SInt16;

begin
theWindowPtr := FrontWindow;

if not IsDialogEvent(theEvent) then
begin
// Handle clicks in document window content region here.
end
else begin
whichModeless := WindowPeek(theWindowPtr)~.refCon;
if (whichModeless = kSearchModeless) then
begin
if DialogSelect(theEvent, dialogPtr, itemHit) then
begin
if (itemHit = kStdOkltemIndex) then
begin
DoButtonHitInSearchModeless;
end;
end;
end;
end;
end;
{ of procedure DolnContent }

11 0000000000000 DoButtonHitinSearchModeless

procedure DoButtonHitInSearchModeless;
var
controlHdI : ControlHandle;
oldPort : WindowPtr;
ignoredErr : OSErr;

begin
ignoredErr := GetDialogltemAsControl(gSearchModelessDialogPtr, iEditText, controlHdl);
GetDialogltemText(Handle(controlHdl), gCurrentString);

GetPort(oldPort);
SetPort(gWindowPtr);
DoDrawMessage(gWindowPtr, false);
SetPort(oldPort);
end;

{ of procedure DoButtonHitinSearchModeless }

11 00000000000 GHHOOHONO NN DoHideModelessDialog

procedure DoHideModelessDialog(theWindowPtr : WindowPtr);
var
whichModeless : SIntl16;
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begin
HideWindow(theWindowPtr);

whichModeless := WindowPeek(theWindowPtr)~.refCon;
if (whichModeless = kSearchModeless) then

begin

gSleepTime := MAXLONG;

end;
end;

{ of procedure DoHideModelessDialog }

11 O00000HMOOOHHNIOOGHOO MO HIOI U000 EventFilter

function EventFilter(theDialogPtr : DialogPtr; {const} var theEvent : EventRecord;
var itemHit : SInt16) : boolean;
var
handledEvent : Boolean;
oldPort : GrafPtr;

begin
handledEvent := false;

if ((theEvent.what = updateEvt) and (WindowPtr(theEvent.message) <> theDialogPtr)) then

begin
DoUpdate(theEvent);
end

else begin
GetPort(oldPort);
SetPort(theDialogPtr);

handledEvent := StdFilterProc(theDialogPtr, theEvent, itemHit);

SetPort(oldPort);
end;

EventFilter := handledEvent;
end;
{ of function EventFilter }

11 O0UAOO0HOOOHIOOGHIOGHMCIHNO MO GHIOOOUNNONHN0 DoPopupMenuChoice

procedure DoPopupMenuChoice(controlHdl : ControlHandle; controlValue, itemHit : SInt16);
var
menuHd| : MenuHandle;
actualSize : Size;
itemName : Str255;
oldPort : GrafPtr;
ignoredErr : OSErr;

begin

ignoredErr := GetControlData(controlHdI, kControlNoPart,
kControlPopupButtonMenuHandleTag, sizeof(menuHdl), @menuHdl, actualSize);

GetMenultemText(menuHdl, controlValue, itemName);

gCurrentString := itemName;

GetPort(oldPort);
SetPort(gWindowPtr);
DoDrawMessage(gWindowPtr, false);
SetPort(oldPort);

if (itemHit = iSound) then
begin
DoPlaySound(itemName);
end;
end;
{ of procedure DoPopupMenuChoice }

11 0000000000 NN DoDrawMessage

procedure DoDrawMessage(theWindowPtr : WindowPtr; inState : boolean);
var
headerRect : Rect;
windowWidth, stringWidth : SInt16;
theState : SInt16;
ignoredErr : OSErr;

begin
theState := integer(inState);

SetRect(headerRect, theWindowPtr~.portRect.left - 1, theWindowPtr~.portRect.top - 1,
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theWindowPtr~.portRect.right + 1, theWindowPtr~.portRect.top + 26);
ignoredErr := DrawThemeWindowHeader(headerRect, theState);

if (theState = kThemeStateActive) then
begin
ignoredErr := SetThemeTextColor(kThemeActiveWindowHeaderTextColor, gPixelDepth,
glsColourDevice);
end
else begin
ignoredErr := SetThemeTextColor(kThemelnactiveWindowHeaderTextColor, gPixelDepth,
glsColourDevice);
end;

windowWidth := theWindowPtr~.portRect.right - theWindowPtr~.portRect.left;
stringWidth := StringWidth(gCurrentString);
MoveTo((windowWidth div 2) - (stringWidth div 2), 17);
DrawString(gCurrentString);
end;

{ of procedure DoDrawMessage }

11 O00OOGHIOOO AU HHIOO KON NN DoPlaySound

procedure DoPlaySound(sndResourceName : Str255);
var
soundHdI : SndListHandle;
soundChanPtr : SndChannelPtr;
ignoredErr : OSErr;

begin
soundChanPtr := nil;

soundHd| := SndListHandle(GetNamedResource('snd ', sndResourceName));
if (soundHdl <> nil) then

begin

ignoredErr := SndPlay(soundChanPtr, soundHdl, true);

end;
end;

{ of procedure DoPlaySound }

11 O000O0MOOOHNIOOO KOOI HNNOO NN DoGetDepthAndDevice

procedure DoGetDepthAndDevice;
var
deviceHd| : GDHandle;

begin
deviceHd| := LMGetMainDevice;
gPixelDepth := deviceHdI™ ~.gdPMap ™ ~.pixelSize;
if (BitTst(Ptr(@deviceHdI”™".gdFlags), gdDevType)) then
begin
glsColourDevice := true;
end;
end;
{ of procedure DoGetDepthAndDevice }

11" GAA000000000000000000000000000000000000000000000000000000000000000 main program block
begin

PRI
initialise global variables

glsColourDevice := false;

gGridSnap := kControlCheckBoxUncheckedValue;
gShowGrid := kControlCheckBoxUncheckedValue;
gShowRule := kControlCheckBoxUncheckedValue;
gBrushType := iCharcoal,;
gSearchModelessDialogPtr := nil;

I i, get nonrelocatable block low in heap for modeless dialog's dialog structure

gPreAllocatedBlockPtr := NewPtr(sizeof(DialogRecord));
if (gPreAllocatedBlockPtr = nil) then

begin

ExitToShell;

end;
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DolnitManagers;
Il open small modal dialog and automatically dismiss it after 10 seconds

{$ifc TARGET_CPU_PPC}
osError := Gestalt(gestaltSystemVersion, response);

if ((osError = noErr) and (response >= $00000850)) then
begin
modalDialogPtr := GetNewDialog(rSplash, nil, WindowPtr(-1));

ignored := SetDialogTimeout(modalDialogPtr,kStdOkltemIndex,10);

repeat
begin
ModalDialog(nil, itemHit);
end;
until (itemHit = kStdOkltemIndex);

DisposeDialog(modalDialogPtr);
end;
{$endc}

] e create routine descriptor for event filter function
gEventFilterUPP := NewModalFilterProc(ModalFilterProcPtr(@EventFilter));

N set
up menu bar and menus

mainMenubarHd| := GetNewMBar(rMenubar);
if (mainMenubarHd| = nil) then

begin

ExitToShell;

end;
SetMenuBar(mainMenubarHdl);
DrawMenuBar,;

mainMenuHdl| := GetMenuHandle(mApple);
if (mainMenuHdI| = nil) then
begin
ExitToShell;
end
else begin
AppendResMenu(mainMenuHdl, 'DRVR');
end;

PN initial advisory text for window
header

gCurrentString := 'Balloon help is available for dialog boxes";

/T TP USRI open a
window, set font size

gWindowPtr := GetNewCWindow(rWindow, nil, WindowPtr(-1));
if (gWindowPtr = nil) then

begin
ExitToShell;
end;
SetPort(gWindowPtr);
TextSize(10);
I get pixel depth and whether colour device for certain Appearance functions
DoGetDepthAndDevice;
1/
entereventLoop ...............................................................................................................................................
EventLoop;
end.

11 000000000000 NG HHOOOGHHO NI U HNNOOON
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Demonstration Program Comments

When this program is run, the user should:

Invoke alert and dialog boxes by choosing items in the Demonstration menu, noting window
update/activation/deactivation and menu enabling/disabling effects.

Choose Show Balloons from the Help menu and pass the cursor over the various items in the dialog boxes, noting
the information in the help balloons. Also note the updating of alert and dialog boxes, and of the window, behind
the help balloon when the balloon closes.

Note the effects on the Apple, Help, and Application menus when the various alert and dialog boxes are the front
window.

Click anywhere outside the modal alert box and modal dialog box when they are the frontmost window, noting that
the only response is the system alert sound.

Note that, when the movable modal alert box and movable modal dialog box are displayed:

. The program can be sent to the background by clicking outside the alert or dialog box and the document
window or by selecting another application from the Application menu.

. The program can be brought to the foreground again by clicking inside the alert or dialog box, or the
docuemnt window, or by selecting the program from the Application menu.

Note that, when the movable modal dialog box is displayed, the Edit menu and its Cut, Copy, and Paste items are
displayed whenever the edit text field has keyboard focus.

Note that, when the modeless dialog box is displayed:

. It behaves like a normal document window when the user:
. Clicks outside it (or selects another application from the Application menu) when it is the frontmost
window.
. Clicks inside it (or selects the program from the Application menu) when it is not the frontmost
window.
. It can be hidden by clicking in the close box or by selecting Close from the File menu.
. A modal alert box, movable modal alert box, modal dialog box or movable modal dialog box can be invoked

"on top of" the modeless dialog box.

. The Edit menu and its Cut, Copy, Paste, and Clear items are enabled so as to support text editing in the edit
text field.

Note that all alert and dialog boxes respond correctly to Return and Enter key presses, and that the modal alert
box, modal dialog box and movable modal dialog box also respond correctly to escape key and Command-period
presses.

Note that, when an alert box or dialog box is the frontmost window, the window and content region are deactivated,
the latter evidenced by dimming of the text in the document window's window header and the drawing of the
header in the deactivated mode.

In the modal dialog box, click on the checkboxes to change their settings, noting that the new settings are
remembered when the dialog box is dismissed using the OK button, but not remembered when the dialog box is
dismissed using the Cancel button. Also, choose items in the two pop-up menu buttons, noting that the chosen
item is displayed in the docuemnt window's window header.

In the movable modal dialog box, click on the radio buttons to change their settings, noting that the new setting is
remembered when the dialog box is dismissed using the OK button, but not remembered when the dialog box is
dismissed using the Cancel button. In the case of the clock control and edit text field, change the item/part with
keyboard focus using the Tab key or by clicking in that item/part. In the case of the edit text field, enter text, and
edit that text using the Edit menu's Cut, Copy, Paste, and Clear items and their Command-key equivalents. Note
that the cursor shape changes whenever the cursor is moved over the edit text field.

In the modeless dialog box, enter text, and edit that text using the Edit menu's Cut, Copy, Paste, and Clear items
and their Command-key equivalents. Note that, because no cursor adjustment function is included in the program,
the cursor shape does not change whenever the cursor is moved over the edit text field. Also note that, when the
Search button is clicked (or the Return or Enter keys are pressed) the text in the edit text field is displayed in the
docuemnt window's window header.

In the 'DITL' resources for the modal and movable modal dialog boxes, note that the item numbers of the primary group
box items are lower than the item numbers of the items visually contained by those group box items. This is to ensure that
the group boxes do not draw over, and thus erase, the image of these contained items.

In the 'alrx' resources, note that all feature flags are set except for the kAlertFlagsAlertlsMovable flag in the 'alrx' resource
for the modal alert box. In the 'dlgx' resources, note that all feature flags are set except for the
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kDialogFlagsHandlesMovableModal flag in 'dlgx' resources for the modal dialog box and modeless dialog box. Thus all alert
and dialog boxes have a root control and embedding hierarchy, and are fully Appearance-compliant.

Although this program only opens one modeless dialog box, a unique value is assigned to the associated window

structure's refCon field to illustrate the usual method for differentiating between the several modeless dialogs boxes a
program could open at any one time.

constants

The first constants are for menu bar, window, and menu resource IDs, and for menu IDs and menu item numbers.
Constants are then established for alert and dialog resource IDs and for the item numbers of certain items in the item lists
associated with the three dialogs. rAlertStrings represents the resource ID of a 'STR#' holding strings for the label and
narrative text for the movable alert box, and the two following constants are used to index these strings. The value
represented by kSearchModeless will be assigned to the modeless dialog box's window structure's refCon field.

The penultimate block of constants represent the character codes for the Return, Enter, escape, and period keys.

Finally, MAXLONG is defined as the maximum possible long value. This value will be assigned to WaitNextEvent's sleep
parameter at program launch.

Global Variables

gPreAllocatedBlockPtr will be assigned a pointer to a pre-allocated block of memory for the modeless dialog box's dialog
structure.

gEventFilterUPP will be assigned a universal procedure pointer to an application-defined event filter function.

gCurrentString will be assigned advisory and other strings for display in the document window's window header.
gWindowPtr will be assigned the pointer to the single window opened by the program. gPixelDepth will be assigned the
pixel depth of the graphics port. glsColourDevice will be assigned true if the graphics device is a colour device and false if it
is @ monochrome device. The values in these last two variables are required by the Appearance Manager function
SetThemeTextColor.

gSleepTime will be assigned the value to be used as the sleep parameter in the WaitNextEvent call. (This value will be
changed during program execution.) gDone controls the exit from the main event loop. glnBackground relates to
foreground/ background switching.

The next three variables will contain the current setting of the checkboxes in the modal dialog box. The next variable will
contain the identity of the newly selected radio button in the movable modal dialog box.

Finally, the pointer to the dialog structure for the modeless dialog box is declared as a global variable.

EventlLoop

The main event loop continues until gDone is set to true by the user choosing Quit from the File menu.
The variable which will be used as WaitNextEvent's sleep parameter (gSleepTime) is initially set to MAXLONG, indicating
that the application has no need for null events and that it will yield the microprocessor to other applications for the

maximum possible time if no events are pending for it. Note that the value assigned to gSleepTime will be changed at
certain points in the program.

Doldle

Doldle is invoked whenever WaitNextEvent returns a null event.

If the front window is the modeless dialog box, the routine IdleControls is called. IdleControls calls the control definition
function of those controls in the specified window which do idle-time processing. In this case, the control is an edit text
field, and the call causes the control definition function to call TextEdit to blink the insertion point caret.

DoEvents

DoEvents branches according to the event type received. (It is important to remember at this point that events that occur
when an alert box, modal dialog box, or movable modal dialog box has been invoked are not handled by the main event
loop but by the ModalDialog function.)

DoMouseDown

DoMouseDown handles mouse-down events. Mouse-downs in the content region and in the close box are of significance to
the demonstration.

If the mouse-down occurred in the content region, and if it was not in the frontmost window, SelectWindow is called to

generate the necessary activate events. If the mouse-down was in the frontmost window, the application-defined function
DoInContent is called to further process the event.
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If a mouse-down occurred in a close box, if TrackGoAway returns true, and if the window is a modeless dialog box, the
application-defined function DoHideModeless is called. (In this demonstration, the modeless dialog box, but not the
document window, has a close box.) Also, the text for the window header is replaced with the default advisory text.

DoKeyDown

DoKeyDown handles all key-down and auto-key events, branching according to whether the event occurred in the modeless
dialog box or the document window.

First, the character code is extracted from the message field of the event structure. Then IsDialogEvent is called to
determine whether the event occurred in a modeless dialog box or a document window.

If the event occurred in a document window, and if the modifiers field of the event structure indicates that the Command
key was down, the application-defined function for adjusting the menus is called, MenuEvent is called to return the long
value containing the menu and menu item associated with the Command-key equivalent, and the long value is passed to
DoMenuChoice for further handling.

If, however, the event occurred in a modeless dialog box, and if that dialog box is the Search modeless dialog box:

. If the key pressed was the Return or Enter key, GetDialogltemAsControl is called to get a handle to the single press
button control in the Search modeless dialog box (item 1 in the item list). The press button is then highlighted for
eight ticks, and then unhighlighted before an application-defined function is called to extract the text from the edit
text field and display it in the document window's window header. DoKeyDown then returns because it is not
intended that the edit text field receive Return and Enter key presses.

. If the Command key was down:

. If either the X, C, or V key was pressed (that is, the user has pressed the Cut, Copy, or Paste Command-key
equivalent), DialogSelect is called to further handle the event. DialogSelect uses TextEdit to cut, copy, or paste
the text in the edit text field. (The calls to HiliteMenu briefly highlight the Edit menu to indicated to the user
that an Edit menu Command-key equivalent has just been used. This replicates the highlighting that
ModalDialog performs when Command-key presses occur in modal and movable modal dialog boxes with edit
text fields.)

. If neither the X, C, nor V key was pressed, the application-defined routine for adjusting the menus is called,
MenuEvent is called to return the long value containing the menu and menu item associated with the
Command-key equivalent, and the long value is passed to DoMenuChoice for further handling.

Thus the Command-key equivalents other than those for Cut, Copy, and Paste remain available to the user via the
main event loop, while the Command-key equivalents for Cut, Copy, and Paste are trapped and passed to
DialogSelect for handling. At the last line in the outer if block, DoKeyDown returns if the Command key was down.

. If the Return key and the Enter key were not pressed, and if the Command key was not down, DialogSelect is called
to handle the keystroke in conjunction with TextEdit, the visual result being that the character appears in the edit
text field.

DoUpdate

DoUpdate performs the initial handling of update events.
If the call to IsDialogEvent reveals that the event is for a window of the document kind, an application-defined routine for

updating the document window is called, otherwise an application-defined routine for updating modeless dialog boxes is
called.

DoUpdateDocument

DoUpdateDocument simply fills the content region of the document window with a colour, using a pixel patter (‘ppat')
resource and a call to FillCRect for that purpose, and then calls an application-defined routine which draws a window
header frame, and some text, in the appropriate mode (activated or deactivated) depending on whether the window is the
frontmost window or not.

DoUpdateModelessDialog

DoUpdateModelessDialog calls DialogSelect to handle the update event. DialogSelect calls BeginUpdate, DrawDialog, and
EndUpdate to redraw the the modeless dialog's content area. (To restrict the redraw to the update region, an alternative is
to call BeginUpdate, UpdateDialog, and EndUpdate.)

DoActivate

DoActivate performs initial handling of activate events.
If the call to IsDialogEvent reveals that the event is for a window of the document kind, the application-defined routine for

activating/deactivating the document window is called, otherwise the application-defined routine for activating/deactivating
a modeless dialog box is called.
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DoOSEvent

DoOSEvent handles operating system events,.

If the event is a suspend/resume event, DoOSEvent calls the appropriate window activation function (depending on whether
the event is for the document window or a modeless dialog), indicating with the value in ginBackground whether the
window should be activated or deactivated.

DoActivateDocument

DoActivateDocument performs window activation/deactivation for the document window.
If the window is becoming active, the menus are adjusted as appropriate for a document window. The call to the

application-defined routine DoDrawMessage draws a window header frame in the window, and some advisory text, in either
the activated or deactivated mode.

DoActivateModelessDialog

DoActivateModelessDialog performs window activation and deactivation for a modeless dialog box.

DialogSelect is called to handle the event. If the modeless dialog box is becoming active, DialogSelect activates all controls
and redraws the one-pixel-wide modeless dialog frame in the undimmed mode. If the modeless dialog box is going to the
back, DialogSelect deactivates all controls and redraws the one-pixel-wide modeless dialog frame in the dimmed mode.

At the next block if the modeless dialog box is becoming active, and if it is the Search modeless dialog box (identified by a
unique value assigned by the application to the dialog window structure's refCon field), the global variable used in the
sleep parameter of the WaitNextEvent function is assigned the value returned by LMGetCaretTime (which is the value set
by the user at the Insertion Point Blinking section in the General Controls control panel). This is necessary to endure that
null events will always be generated, and thus Doldle and IdleControls will be called, at an interval short enough to ensure
insertion point caret blinking at the proper rate. (The differentiation between modeless dialog boxes in this instance is for
illustrative purposes only, since the program only ever opens one modeless dialog box. Other modeless dialog boxes might
not necessarily contain edit text fields.)

If the Search modeless dialog box is to be deactivated, the sleep parameter for the WaitNextEvent function is reset to the
maximum long value.

DoAdjustMenus

DoAdjustMenus is called by the document window and modeless dialog box activation routines to adjust the menus as
appropriate to the type of the frontmost window, that is, whether the frontmost window is the document window or the
modeless dialog box.

DoMenuChoice

DoMenuChoice handles menu choices.

If the choice was the Quit item in the File menu, gDone is set to true, thus terminating the program. If the choice was the
Close item in the File menu, and if the front window is a modeless dialog box, an application-defined routine which hides
modeless dialog boxes is called. (In this program, and because the document window does not have a close box, the Close
item is only enabled when the modeless dialog box is the front window.)

DoEditMenu

DoEditMenu first determines whether the front window is a modeless dialog box, and whether it is the Search modeless
dialog (which has an edit text field). If so, Cut, Copy, Paste, and Clear selections from the Edit menu will cause the Dialog
Manager, in conjunction with TextEdit, to perform those operations on selected text in the edit text field. The call to the
application-defined routine DoFixEditTextBackground following the Cut, Paste, and Clear calls is intended to compensate
for what appears to be a small bug in the edit text field control definition function (see below).

DoDemonstrationMenu

DoDemonstrationMenu handles choices from the Demonstration menu, branching according to the menu item passed to it.
(Error handling in this function is somewhat rudimentary in that the program simply terminates.)

If the user chose Modal Alert, StopAlert is called to create, display, manage, and dispose of the modal alert box. Before
invoking any type of alert box, however, an application must explicitly deactivate the front document window, if one exists.
Accordingly, an application-defined routine is called to perform that action. Note that a universal procedure pointer to an
application-defined event filter function is passed in StopAlert's second parameter. StopAlert handles all user interaction
within the modal alert box, disposing of the alert box when the user clicks the OK button or presses the Return key.

If the user chose Movable Modal Alert, the application-defined routine which deactivates the frontmost document window (if
one exists) is called, following which the application defined routine which creates, displays, handles user interaction, and
disposes of the movable modal alert box is called. (As will be seen, for the movable modal alert box also uses the
application-defined event filter function.)
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if the user chose Modal Dialog or Movable Modal Dialog, the same general procedure is followed, except that the
application-defined routine which creates, displays, handles user interaction, and disposes of the modal dialog or movable
modal dialog is called. (As will be seen, for the modal dialog box and movable modal dialog box also use the application-
defined event filter function.)

If the user chose Modeless Dialog, the application-defined routine for creating and displaying the modeless dialog box is
called.

DoEXxplicitlyDeactivateDocument

DoExplicitlyDeactivateDocument is called prior to the opening of all but the modeless dialog box to explicitly deactivate the
frontmost document window (if one exists).

If there is at least one window of any type open, and if that front window is of the document window kind, the application-
defined routine for activating/deactivating document windows is called to deactivate the window.

DoMovableModalAlert

DoMovableModalAlert creates, displays, manages, and disposes of the movable modal alert box. Unlike the modal alert
box, and all the dialog boxes, the movable modal dialog box in this demonstration is created programmatically, rather than
from 'ALRT' and 'alrx' resources.

At the first nine lines, values are assigned to the fields of a standard alert structure. In sequence: the alert box is to be a
movable modal alert box; a help button is not to be displayed; the event filter function used is to be the application-defined
event filter function pointed to by the universal procedure pointer geventFilterUPP; the default text for the OK button is to
be used; the default text for the Cancel button is to be used; no "left-most" button is required; the default push button is to
be the first push button (which will thus have the default ring drawn around it and have the Return and Enter keys aliased
to it); the Cancel push button is to be the second push button (which will thus have escape and Command-period key
presses aliased to it); the alert box is to be displayed in the alert position on the parent window screen. (With regard to the
last field, in this structure, the constant kWindowDefaultPosition equates to kWindowAlertPositionParentWindowScreen.)

The two calls to GetIndString retrieve the specified strings from the specified 'STR#' resource. These are passed in the
label text and narrative text parameters in the following call to StandardAlert.

The call to StandardAlert creates and displays the alert, handles all user interaction (by internally calling ModalDialog),
including dismissing the alert box when either the OK or Cancel buttons are hit. (The item hit is returned in StandardAlert's

last parameter. In a real application, the appropriate action would be taken, based on which item was hit, following the call
to StandardAlert.)

DoModalDialog

DoModalDialog creates, displays, manages, and disposes of the modal dialog box.

The call to GetNewDialog creates the modal dialog box from the specified resource as the frontmost window.

The call to SetDialogDefaultltem tells the Dialog Manager which is the default push button item, to alias the Return and
Enter keys to that item, and to draw the default ring around that item. The call to SetDialogCancelltem tells the Dialog
Manager which is the Cancel push button item, and aliases the escape key and Command-period key presses to that item.

The next block gets handles to the three checkbox controls and sets the value of those controls to the current values
contained in the global variables relating to each control.

With the modal dialog box fully prepared, it is made visible by the call to ShowWindow.

The repeat/until loop continues to execute until ModalDialog reports that either the OK or Cancel button has been "hit".
Within the loop, ModalDialog retains control until one of the enabled items has been hit.

If a checkbox is hit, GetDialogltemAsControl is called to get a handle to the control and SetControlValue is called to flip that
control's control value. (Ifitis O, itis flipped to 1, and vice versa.) If one of the pop-up menu buttons is hit,
GetDialogltemAsControl is called to get a handle to the control and GetControlValue is called to get the menu item number
of the menu item chosen, following which an application defined function is called to extract the menu item text and
display it in the window header. (In the case of the Sound pop-up menu button, an additional routine is called to play the
associated 'snd ' resource.)

Note that the first parameter in the ModalDialog call is a universal procedure pointer to the application-defined event filter
function.

When the repeat/until loop exits, and if the user hit the OK button, handles to each of the three checkboxes are retrieved
for the purposes of retrieving the control's value and assigning it to the relevant global variable. (If the user "hit" the
Cancel button, the global variables retain the values they contained before the dialog was created and displayed.)

The dialog is then disposed of, and true is returned to the calling function. (The change to gCurrentString simply causes
the text displayed in the window header text to be replaced with the default advisory text.)

DoMovableModalDialog

DoMovableModalDialog creates, displays, manages, and disposes of the movable modal dialog box.
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The call to GetNewDialog creates the movable modal dialog box from the specified resource as the frontmost window.

The call to SetDialogDefaultltem tells the Dialog Manager which is the default push button item, to alias the Return and
Enter keys to that item, and to draw the default ring around that item. The call to SetDialogCancelltem tells the Dialog
Manager which is the Cancel push button item, and to alias the escape key and Command-period key presses to that item.
The call to SetDialogTracksCursor tells the Dialog Manager to track the cursor and change it to the I-Beam cursor shape
whenever it is over an edit text field.

The first call to GetDialogltemAsControl gets a handle to the radio button control represented by the current value in the
global variable gBrushType. The value of that control is then set to 1. The second call to GetDialogltemAsControl gets a
handle to the clock control. The call to SetKeyboardFocus sets the keyboard focus to that item.

Before the session of user interaction begins, the current value in the global variable gBrushType, which stores the item
number of the currently selected radio button, is copied to the local variable oldBrushTupe.

With the movable modal dialog box fully prepared, it is made visible by the call to ShowWindow.

The repeat/until loop continues to execute until ModalDialog reports that either the OK or Cancel button has been "hit".
Within the loop, ModalDialog retains control until one of the enabled items is hit.

If a radio button is hit, a for loop sets the control value of all radio button controls to 0. A call to GetDialogltemAsControl
then gets a handle to the radio button control that was hit. A call to SetControlValue then sets that control's value to 1,
and the item number of this radio button is assigned to the global variable gBrushType.

Note that the first parameter in the ModalDialog call is a universal procedure pointer to the application-defined event filter
function. Note also that all user interaction relating to the clock control and edit text field is handled automatically by
ModalDialog, including the movement of keyboard focus between the items.

When the repeat/until loop exits, and if the user hit the Cancel button, the value stored in the local variable oldBrushType is
assigned to gBrushType, ensuring that any change to the currently selected radio button within the do/while loop is
ignored. (In a real application, a long date/time value from the clock control, and the text from the edit text field would
possibly be retrieved at this point if the user hit the OK push button.)

The dialog is then disposed of, and true is returned to the calling routine.

DoCreateOrShowModelessDialog

In this program, the modeless dialog box is only created once, that is, when the user first chooses Modeless Dialog from the
Demonstration menu. Clicks in its close box, or choosing Close from the File menu while the modeless dialog is the
frontmost window, will cause the dialog box to be hidden, not disposed of.

Accordingly, the first line determines whether the modeless dialog box is already open. Ifit is not: the call to GetNewDialog
creates the modeless dialog box (with the previously pre-allocated nonrelocatable block passed in the second parameter);
the call to SetWRefCon assigns the constant kSearchModeless to the refCon field of the dialog's window structure so as to
facilitate the future identification of this particular modeless dialog box; a call to SetControlData with the
kControlPushButtonDefaultTag tag constant causes the control definition function to draw the default ring around the
specified push button; a call to SetDialogltemText assigns some initial text to the edit text field; a call to
SelectDialogltemText selects the text in the edit text field. (Note that, if the edit text field did not contain text, this latter
call would simply display the insertion point caret, which would be made to blink by the call to IdleControls within the
application-defined function doldle.)

If, on the other hand, the modeless dialog box has already been opened, the call to ShowWindow displays the dialog box
and the call to SelectWindow generates the necessary activate events.

DolnContent

DolnContent continues the content region mouse-down handling initiated by DoMouseDown. DolnContent is called by
DoMouseDown only if the mouse-down occurred in the frontmost (active) window.

The first line gets a pointer to the frontmost window.

If the event occurred in the document window, the mouse-down event would be handled in the if section of the if/then/else
block. (No action is required in this demonstration.)

If the event occurred in a modeless dialog box, and if that modeless dialog box is the Search modelss dialog box (which
contains an edit text field), DialogSelect is called to handle the event. DialogSelect tracks enabled controls (only the push
button is enabled), returning true if the mouse button is released while the cursor is still inside the control, and highlights
any selection made in the edit text field. If DialogSelect returns true, and if the item hit was the OK (Search) push button,
an application-defined routine is called to perform the actions required in the event of a hit on that button.

DoButtonHitInSearchModeless

DoButtonHitInSearchModeless further processes, to completion, a hit on the OK (Search) button in the modeless dialog box.
It simply demonstrates retrieval of the text in an edit text field in a dialog box.
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The call to GetDialogltemAsControl gets a handle to the edit text field, and the call to GetDialogltemText copies the text in
the edit text field to the global variable gCurrentString. The following lines cause that text to be drawn, in the dimmed
mode, in the window header in the document window.

DoHideModelessDialog

DoHideModelessDialog hides a modeless dialog box.

The call to HideWindow makes the dialog box invisible. If the modeless dialog box is the Search modal dialog box, the
sleep parameter for the WaitNextEvent function is reset to the maximum possible long value, because insertion point caret
blinking is not required while the Search dialog box is hidden.

EventFilter

EventFilter is the application-defined event filter function which, in conjunction with ModalDialog, handles events in all alert
and dialog boxes except the modeless dialog box. In this program, a universal procedure pointer to EventFilter is passed as
the first parameter in the StopAlert and ModalDialog calls.

If the event is an update event, and if it is not for the dialog box or alert box in question, the application's document
window updating function is called, and false is returned. This response to an update event in the application's own
document windows also allows ModalDialog to perform a minor switch when necessary so that background applications can
update their windows as well.

If the event is not an update event, the current graphics port is saved and then set to that of the alert or dialog box. The
event is then passed to the standard event filter function for handling. If the standard event filter function handles the
event, it will return true and, in the itemHit parameter, the number of the item that it handled. ModalDialog (and StopAlert,
which calls Modal Dialog internally) will then return this item number. A call to SetPort then restores the previously save
graphics port.

Note that the calls to GetPort and SetPort are actually redundant when this event filter function is used by all but the
movable modal dialog box. The calls are only necessary when SetDialogTracksCursor has been called to cause the Dialog
Manager to automatically track the cursor, and the movable modal dialog box is the only modal alert or dialog box which
requires this tracking (because it contains an edit text field.)

DoPopupMenuChoice, DoPlaySound,
DoDrawMessage, and
DoGetDepthAndDevice

DoPopupMenuChoice, DoPlaySound, DoDrawMessage, and DoGetDepthAndDevice are incidental to the demonstration. All
perform the same duties as the similarly-named routines in the demonstration program Controlsl, which is associated with
Chapter 7 — Introduction to Controls. DoDrawMessage is used in this program to prove the explicit deactivation of the
document window's content area when alert and dialog boxes other than the modeless dialog box are invoked.

main program block

After the call to dolnitManagers, and provided Mac OS 8.5 or later is present, GetNewDialog is called to create a small
modal dialog. SetDialogTimeout is then called with 10 (seconds) passed in the inSecondsToWait parameter and 1 passed
in the inButtonToPress parameter. (In the associated 'DITL' resource, Item 1 is the OK push button, which has been
hidden.) The use of SetDialogTimeout requires that the application handle events for the dialog box through the
ModalDialog function, hence the ModalDialog do-while loop. This allows the Dialog Manager to simulate an item selection.
After 10 seconds, the Dialog Manager simulates a user click in the (invisible) OK button, causing the do-while loop to exit.
The dialog is then disposed of.

The modeless dialog will be created when the user chooses the Modeless Dialog item in the Demonstration menu, and will
remain in existence until the program terminates. To avoid heap fragmentation effects, the nonrelocatable block for the
modeless dialog's dialog structure is pre-allocated here, before the system software managers are initialised, so as to
ensure that it is located as low in the heap as possible.

After the system software managers are initialised, a call to NewModalFilterProc creates a routine descriptor for the event
filter function. (If this program was required to be compiled as 68K code only, this routine descriptor would not be
required.)

RegisterAppearanceClient is called to ensure that the new Appearance-compliant menu bar definition function (resource ID
63) will be used regardless of whether system-wide Appearance is selected on or off in the Appearance control panel.

The next block sets up the drop-down menus.

A value is assigned to the global variable gCurrentString. The string in gCurrentString, which will be changed at various
points in the code, will be drawn in the document window's window header.

The next block opens a window and sets the font size for the window to 10pt.
The call to the application-defined routine DoGetDepthAndDevice determines the current pixel depth of the graphics port,

and whether the current graphics device is a colour device, and assigns the results to the global variables gPixelDepth and
glsColourDevice.
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The main event loop is then entered, and continues until gDone is set to true.

Note that error handling here and in other areas of this demonstration program is somewhat rudimentary. In the unlikely
event that certain calls fail, ExitToShell is called to terminate the program.
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EDIT TEXT CONTROL BACKGROUND COLOUR PROBLEM

There was an apparent bug in the version of the edit text control CDEF included with Versions 1.0 through 1.0.3 of
the Appearance Manager, but which is not evident in the version of the CDEF included with Mac OS 8.5. This bug
manifested itself in the edit text item in the modeless dialog of the demonstration program as corruption of the text

background colour whenever a cut, clear, or paste was made via the Edit menu (though not via the Command-key
equivalents).

If you are running this demonstration under a version of the Mac OS earlier than 8.5, this bug will almost certainly be
evident. One workaround is to force a re-draw of the edit text item in the modeless dialog immediately after
DialogCut, DialogClear, and DialogDelete are called. Proceed as follows:

Add this routine declaration:
procedure DoFixEditTextBackground; forward;

Add this procedure:

11 0000A0000A000MMAC0NOGHHOOGH0NO0NNOONK) DoFixEditTextBackground

procedure DoFixEditTextBackground;
var
controlHdI : ControlHandle;
ignoredErr : OSErr;

begin
ignoredErr := GetDialogltemAsControl(gSearchModelessDialogPtr, iEditText, controlHdl);
ignoredErr := DeactivateControl(controlHdl);
ignoredErr := ActivateControl(controlHdl);
end;
{ of procedure DoFixEditTextBackground }

In the DoEditMenu function, add a call to DoFixEditTextBackground immediately after the calls to DialogCut,
DialogClear, and DialogDelete.
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